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PART 1: ON1 EFFECTS 2019 OVERVIEW

ON1 Effects 2019 is a complete stylizing tool for your photos. With a professional-grade effects engine that 
includes 27 filters, Effects gives you endless possibilities for finishing your photos, with extensive stacking, 
masking and blending options; hundreds of borders and textures; and a set of local adjustment tools for 
applying basic tone and color options to your images. To help get you started, ON1 Effects 2019 comes with 
more than 100 built-in presets, and you can save and apply your own presets with the click of a button.

You can use ON1 Effects 2019 as a standalone app, simply by dragging and dropping photos, or as a plug-in 
to a photo editor such as Adobe’s Photoshop, Lightroom Classic CC, Photoshop Elements or Apple Photos, 

Using the Help System
Find and watch free video tutorials at the ON1 Effects 2019 Product Training site, available at ON1.com. 
This is the best and quickest way to dig into the ON1 workflow and discover new techniques that will help 
you with your photo editing and organizing. There, you can search our Knowledge Base for frequently 
asked questions, common issues and more.

https://www.on1.com/blog/category/product-training/
https://on1help.zendesk.com/hc/en-us
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System Requirements

MINIMUM RECOMMENDED
OPERATING SYSTEM Mac OS 10.11 through 10.14; 

Windows 7, Windows 8 or 
Windows 10 current releases, 
64-bit only

Mac OS 10.12 through 10.14; 
Windows 10 current releases, 
64-bit only

PROCESSOR Intel Core 2 Duo, Xeon or 
better processor

Intel Core i5, Xeon or better 
processor

RAM 4 GB (8 GB when used as a 
Photoshop plug-in)

16 GB RAM

HARD DRIVE 1.5 GB for installation 1.5 GB for installation 
Fast (7200 RPM) or SSD drives

DISPLAY OpenGL 3.3 compatible video 
card with 512 MB video 
RAM,1280x720 resolution

OpenGL 4.2 compatible video 
card with 1 GB dedicated video 
RAM, 1920x1080 resolution

THIRD-PARTY APPS 

SUPPORTED (PLUG-IN)

Photoshop CS6, CC (all versions) 
Photoshop Elements 14 and higher 
Photoshop Lightroom 6, Lightroom Classic CC (all versions) 
Apple Photos

OTHER Internet connection for 
activation, auto update 
checking, content downloads 
and tutorials.

Internet connection for 
activation, auto update checking, 
content downloads and tutorials.

Wacom tablet for pressure-
sensitive input

Hardware display calibration tool

Installation
To install ON1 Effects 2019, double-click the installer icon and let the installer guide you. Be sure to close 
any supported host applications such as Adobe Photoshop, Elements or Lightroom, as well as any previous 
versions of ON1 products before installing or updating.

MAC OS

The application is installed in the ON1 Effects 2019 folder in the Applications folder.

All plug-in files for supported host applications (Adobe Photoshop, Lightroom, Photoshop Elements or 
Apple Photos) found during the installation process will be installed automatically. You will see a summary 
of installed plug-ins at the end of installation.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.
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WINDOWS

The application is installed in the ON1 Effects 2019 directory in the ON1 directory in the Program Files 
directory.

All plug-in files for supported host applications (Photoshop, Lightroom, Photoshop Elements) will be 
installed automatically. You will see a summary of installed plug-ins at the end of installation.

If a previous version of ON1 Effects is found, it will be maintained or replaced based on your preference 
during installation.

Support files are installed into \ProgramData\ON1\ on Windows.

Launching ON1 Effects 2019
Follow these steps to launch Effects 2019 as a standalone app:

MAC OS

1.	 Open a window in the Finder.

2.	 Navigate to the Applications folder.

3.	 Navigate to the ON1 Effects 2019 folder.

4.	 Double-click on the ON1 Effects 2019 application icon.

You can add ON1 Effects 2019 to your dock for easy access by clicking and holding the icon in the dock 
and selecting the Keep In Dock option. If you use Launchpad it can be found there as well.

WINDOWS 7

1.	 Go to your Start Menu.

2.	 Select the ON1 group.

3.	 Select ON1 Effects 2019.

4.	 If you selected the “Add Icon to Desktop” option during installation you can also access ON1 
Effects 2019 from there.

WINDOWS 8.1 AND WINDOWS 10

1.	 Open the Start screen by pressing the Window key.

2.	 Select ON1 Effects 2019.

3.	 If you selected the “Add Icon to Desktop” option during installation you can also access ON1 
Effects 2019 from there.

To launch ON1 Effects 2019 from an external application, such as Adobe Photoshop or Lightroom, see the 
sections below for complete instructions.
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Licensing and Registration
When you first launch ON1 Effects 2019, you will be presented 
with a window asking you to activate your software. In this 
window, you can either enter your ON1 account information (if 
you have purchased the app) or can start a free trial of the app.

IF YOU HAVE PURCHASED EFFECTS 2019:

Click on the “Owners Sign-in” button and fill in your ON1 account 
information (email and password) to register the app with us. (You 
should have set up an account when you purchased the software.) 
If the computer you are signing in with does not have access to 
the internet, you can manually register your software by clicking 
on the “No Internet connection” link in the license dialog.

Your license lets you install ON1 Effects 2019 on five computers. When you enter your ON1 account info, 
Effects 2019 communicates with the ON1 activation server and registers your software for that computer.

If you wish to move your copy of ON1 Effects 2019 from one registered computer to a new one, and you 
are not going to be using the older machine, it is best to sign out of the old computer first. Open Effects 
2019 and select Sign Out from the Help menu. This will turn off Effects 2019 on the current machine, and 
you can install and sign in on another machine.

You can log into your ON1 user account area (q) at any time to download the software, see the number of 
computers you have registered, and make basic changes to your account information, including updating 
your email address, changing your password, and turning notifications on or off.

If you have issues related to installing or activating Effects 2019, please contact ON1’s customer support, 
which can be reached by clicking on the Support tab (on1help.zendesk.com/hc/en-us) on the ON1 website.

TRIAL VERSION

ON1 Effects 2019 can also operate as a fully featured trial version for 30 days from when you first launch 
it. This gives you time to evaluate the product and see if it fits your needs. If you have downloaded Effects 
to try it out, simply click on the Trial button in the Sign In window. Each time you launch Effects 2019 
during the trial period, you will see the window, which will tell you how many days remain in the trial.

You can purchase ON1 Effects 2019 at any time from this window by clicking on the Purchase button. 
If you do that, just enter your ON1 account information the next time you launch the product and the 
activation window will no longer appear.

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 

https://on1help.zendesk.com/hc/en-us
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Product Improvement Program. The Product Improvement Program is built into our software and gathers 
information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 Effects 
2019. You can change your participation later: select ‘Help Improve ON1 Products’ from the Help menu.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Uninstalling ON1 Effects 2019
To uninstall ON1 Effects 2019, first deactivate your product, by opening ON1 Effects 2019 and selecting 
‘Sign Out…’ from the Help menu. (This will allow you to transfer your license to another computer.)

MAC OS

1.	 Go to the Applications/ON1 Effects 2019/Documentation folder.

2.	 Double-click on the Remove ON1 Effects 2019 application.

WINDOWS

1.	 Go to Control Panels.

2.	 Under Programs select Uninstall a program.

3.	 In the list that comes up select ON1 Effects 2019 and then click on the Uninstall button.

Opening photos from within ON1 Effects 2019
ON1 Effects 2019 can open the following file types, in RGB color mode, either 8 or 16 bits per pixel.

• Raw files from most major camera manufacturers

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)
The Open Photo icon is 
displayed in the center of the 
main Effects 2019 window.
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When you first launch ON1 Effects 2019, you’ll see the Open Photo icon in the center of the main window. 
To open an image, you can either drag an image anywhere into the window from the desktop, or you can 
click on the Open button to navigate to a specific file.  

Once you’ve selected an image, Effects will present you with a dialog box that gives you options for what 
happens when you save your edits. You have two main options, to edit a copy of the original file, or you 
can edit the original. Choosing the latter option will make all of your edits on the original file, overwriting it 
when you save the image. (In general, we don’t recommend this option, especially if you are working on JPG 
files, since the saving process can introduce artifacts by applying additional compression to your image.)

The other option, Edit a Copy with Settings Attached, will make a copy of your image for editing in Effects. 
If you choose that setting, the Copy Options section of the dialog box gives you the following options:

1.	 File Format: Sets the file type of the copy: 
Photoshop (PSD), TIFF, or JPEG. 

2.	 Color Space: Sets the default color space when 
opening the file; the list includes Adobe RGB 
1998, Apple RGB, sRGB, ProPhoto RGB, or 
ColorMatch RGB.

3.	 Bit Depth: Sets the bit depth for the file; the 
choices are 8- or 16-bit.

4.	 Resolution: Sets the file’s output resolution.

5.	 Don’t ask me again: If wish to use the same 
settings each time you open an image, click 
this box. (This setting can be changed in 
Preferences’ Files tab.)

SAVING YOUR IMAGES AFTER EDITING IN EFFECTS 

After your editing session, click the Done button at the bottom of the Effects window to save your image. If 
you don’t wish to save your edits, click the Cancel button.

Using ON1 Effects 2019 with Adobe® Photoshop®
When you edit an image sent from Photoshop to ON1 Effects 2019, you are editing Photoshop’s currently 
selected layer. By default, Effects  makes a copy of the layer, so your original layer is saved, unless it 
is a Smart Object (see below). If you’d like to change this preference, see the Plug-Ins section of the 
Preferences window on page 74.

ON1 Effects 2019 is accessible from within Photoshop in two ways, from the File > Automate menu, and 
from the Filter > ON1 menu. 

There are two options for editing an image in ON1 Effects 2019. Which method you choose depends upon 
whether you wish to be able to re-edit your image in Effects.

Effects’ What to Edit dialog box gives you two options for what 
happens when you are finished editing your image.
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EDITING A PHOTO FROM PHOTOSHOP WITHOUT PRESERVING 
CHANGES MADE IN EFFECTS

To use Effects from inside Photoshop, when you do not wish so be able to re-edit your operations, follow 
these steps:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on. Make a duplicate if you want to preserve the original 
layer (Layer > Duplicate).

3.	 From the Filter menu, select ON1 and then the Edit module tab you would like to start in.

4.	 When you’re finished editing your photo, click the Done button in ON1 Effects 2019. 

EDITING A PHOTO FROM PHOTOSHOP TO PRESERVE CHANGES 
MADE IN EFFECTS

To be able to re-edit your Photoshop images at a later point 
inside ON1 Effects 2019, you will use Photoshop’s Smart Object 
technology. To do this, follow these steps:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on.

3.	 Right-click on the layer and choose Convert to Smart 
Object.

4.	 From the Filter menu, select ON1 and then the tab that 
you would like to use.

5.	 When you’re finished editing your photo, click the Done 
button in Effects 2019.

To re-edit your Smart Object layer again inside ON1 Effects 2019, 
double-click on the ON1 Effects name in the edited Smart Object layer 
in Photoshop. Effects will then launch that module, and let you change 
your previous settings or make new ones.

Right-clicking on a layer in Photoshop’s Layers 
panel gives you the option to turn the layer into a 
Smart Object..

To re-edit a Photoshop layer in 
Effects, double-click the module 
name in the Smart Filters section of 
the Layers palette.
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Using Effects with Adobe® Photoshop Elements®
When you edit an image sent from Photoshop Elements to ON1 Effects 2019, you are editing Photoshop 
Elements’ currently selected layer. By default, Effects makes a copy of the layer, so your original layer is 
saved. If you’d like to change this preference, see the Plug-Ins section of the Preferences window (page 
74).

Effects 2019 is accessible from within Photoshop Elements in two ways, from the File > Automation Tools 
menu, or from the Filter > ON1 menu. 

EDITING A PHOTO IN PHOTOSHOP ELEMENTS

To use Effects inside Photoshop Elements, follow these steps:

1.	 Open the image you want to work on in Photoshop Elements.

2.	 Select the layer you want to work on. 

3.	 From the Filter menu, select ON1 and then ON1 Effects 2019.

4.	 When you’re finished editing your photo, click the Done button in Effects.

NOTE: Photoshop Elements does not support Smart Objects, so all edits done 
inside ON1 Effects 2019 are final, after you return to Elements.

Using Effects with Adobe® Lightroom® Classic
ON1 Effects 2019 can be accessed from within Lightroom Classic CC, providing an integrated, round-trip 
workflow of your images. 

There are two primary ways to use ON1 Effects 2019 with Lightroom, via the Plug-In Extras command in 
the File menu and the Edit In command in the Photo menu. 

ACCESSING EFFECTS 2019 VIA ‘PLUG-IN EXTRAS’

Accessing ON1 Effects 2019 from the File 
> Plug-in Extras menu is the preferred way 
to access the app. It gives you the most 
flexibility in how the files are handled. To 
edit an image in Effects, select the image in 
Lightroom, go the File menu and select the 
Plug-In Extras submenu, and choose ON1 
Effects 2019.

The Plug-In Extras submenu is found in Lightroom’s File menu.



ON1 Effects 2019 from A-Z	 Part 1: Overview	 9

File Creation Characteristics When Using Plug-In Extras

When you use ON1 Effects 2019 through the Plug-In Extras menu there are important file-handling 
options that are controlled in the Files tab of Effects’ Preferences dialog. These need to be configured in 
advance, based on your desired workflow. Once these are set, all images sent to Effects via the Plug-In 
Extras submenu will use these characteristics:

• File Format: The file type menu determines 
what type of file will be created. The default 
is PSD, which maintains layers. You can also 
select JPG or TIFF, if you prefer those formats 
and don’t need to maintain layers.

• Color Space: The color space menu determines 
what RGB working color space is used; Adobe 
RGB 1998, sRGB or ProPhoto RGB.

• Bit Depth: The bit-depth drop-down menu has 
two options: 8 or 16 bits per pixel.

• Resolution: The resolution drop-down menu 
determines the resolution of the file.

USING ‘EDIT IN’ FROM LIGHTROOM

For quick editing of photos in Effects, select 
your image in Lightroom, go to the Photo menu 
and select the Edit In submenu and choose ON1 
Effects 2019.  

The editing conditions when using Photo > Edit 
in are the same as those when you use the File > 
Plug-In Extras. 

File Creation Characteristics When Using Edit In

When you use the Photo > Edit In submenu, Lightroom will ask you 
each time how you wish to edit the selected image. You have three 
editing options—Edit a Copy with Lightroom Adjustments, which 
makes a copy of the file that includes any edits you have made in 
the photo; Edit a Copy, which copies the original photo without any 
changes made in Lightroom; or Edit Original, which is not available if 
the photo being sent to Effects is a raw file.

You can also can set the file type (TIFF, Photoshop or JPEG), the color 
space and bit depth for the resultant file. 

When sending a file from Lightroom to Effects via Lightroom‘s 
Plug-In Extras menu, the edited file will be created according to the 
settings in the Files section of Effects’ Preferences window.

The Edit In submenu can be found in Lightroom’s Photo menu.
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Using ON1 Effects 2019 with Apple® Photos
ON1 Effects 2019 integrates tightly with Apple Photos (for Mac OS only) and provides a seamless 
experience for enhancing your images. 

SETTING UP APPLE PHOTOS TO WORK WITH EFFECTS

If you have Apple Photos on your computer 
when you install ON1 Effects 2019, the 
appropriate plug-in will be installed, but you 
must first manually activate it in order to 
use it. 

To do so, go to Apple’s System Preferences 
and click on the Extensions icon. In the 
Extensions pane, click on Photos Editing, 
then check the ON1 Effects 2019 box. This 
will let you send images from Apple Photos 
to Effects 2019. (File Sharing must also be 
turned on in System Preferences for this to 
work.)

To edit an image in ON1 Effects 2019 follow these steps:

1.	 Select the image you wish to edit in Photos.

2.	 Click on the Edit button.

3.	 On the top right side of the editing window, to the right of 
the Info button, you’ll see the Extensions icon, designated 
by a circle with three dots inside it. Click on that button, and 
choose ON1 Effects 2019 from the pop-up.

After installing Effects 2019 on your Mac, you must turn the Photos extension on via 
Apple’s Extensions System Preference. (File Sharing, also accessed from System 
Preferences, must also be turned on for Apple Photos extensions to work.)

Click on the Extensions button inside 
Apple Photos’ editing window to send an 
image to Effects 2019.
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Extras
ON1 Effects 2019 supports a number of additional file types that can be used in various modules. These 
files are called Extras, and the file types include:

• Presets

• Borders

• Textures

• Look-up tables (LUTs)

ON1 includes a number of extras in the product when you install Effects, and you can create your own, or 
add extras downloaded from the ON1 website. You can use the Extras Manager to import and manage your 
own extras, creating categories for each type, and deleting extras that you no longer want.

HOW TO IMPORT EXTRAS

To import extras, open a photo and choose Manage Extras from the File menu, and follow these steps:

1.	 Select the type of extras you wish to import from the list of tabs at the top (Presets, 
Borders, Textures, LUTs) You can only import extras of one type at a time.

2.	 Click on the Import button at the bottom left. A dialog box will appear where you can select 
the files to import. If you want to import an entire folder, open the folder, select the first file, 
then shift-click on the last file. Click import when your selection is complete.

3.	 Select a category for your extras to live in. This is where you will be able to find it inside of 
the ON1 Effects 2019. You can select from an existing category or create a new one.

When your extras have been imported you will see them in the Extras Manager in the category you 
selected, in the type of extra they belong to.

Organizing Presets

The Presets tab of the Extras Manager gives you additional options for working with large groups of 
presets inside Effects. When you are using the Presets tab, you’ll see ‘+’ and ‘-’ buttons, which let you add 
or delete categories to the list of your presets. 

You can also add subfolders to any of the Presets categories, which can help organize and manage large 
collections of presets. You can use drag-and-drop to move existing categories into another, or you can add 
a category subfolder to an existing category by clicking on the category and then clicking on the ‘+’ button 
in the Extras Manager window. (When you are importing presets, Effects gives you the opportunity to add 
presets to any category folder or subfolder.)

In addition to the Import option, the Presets section of the Extras Manager will also let you export presets, 
for sharing with other users, or to archive seldom-used presets. To export a complete category, click on the 
category in the list on the left side of the window and click on the Export button. This will export a folder 
that contains a single .ONpreset file, which includes all of the presets from that category. If you would like 
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to export a single preset, click on the preset from the list on the right side of the window and click Export.

What Type of Images Can I Import as Extras?

Backgrounds and textures may be any image file that Effects can open, including JPEG, TIFF, raw or 
Photoshop files. Border files must have a large central area that is transparent, so only files that support 
transparency, such as PNG, can be imported as borders. LUTs can be in either .3DL or .CUBE format.

NOTE: If you download an .ONPreset or .ONP file for Effects, double-click it 
to install it. For more info, see the Presets section, starting on page 32.

USING EXTRAS IN EFFECTS

You can access LUTs, borders and textures—inside of Effects. To use them follow these steps:

1.	 Open an image into Effects.

2.	 In the Filter Options pane, select either the Borders or Textures filter type.

3.	 From the Category pop-up, select a category you have imported. User-added extras 
categories will appear at the bottom of the category list.

4.	 From the Texture or Borders pop-up select a texture or border from the desired category.

The Extras Manager lets you import presets, textures, backgrounds, borders, and look-up tables 
(LUTs) for use with the different modules in ON1 Effects 2019. You can also create subcategories 
of presets, to help organize your collection.
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NOTE: More information on the Borders, Textures and LUTs filters can be 
found in the Filters section of this user guide, on page 46 (Borders), page 
51 (LUTs) and page 54 (Textures).

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1.	 Open the Extras Manager in any module (File > Manage Extras).

2.	 Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.

3.	 To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4.	 To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.
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PART 2: WORKING IN EFFECTS
ON1 Effects 2019’s photo-editing power consists of two distinct editing functions, separated into tabs:

• Effects is the stylization center of Effects, with 27 filters—offering such operations as black 
and white conversion, HDR stylizing, glows, sharpening, color enhancement and more— that 
can be stacked in any order, all with extensive blending and masking options. (Filters are 
discussed in detail, starting on page 37.)

• Local Adjustments are designed to apply basic, targeted edits to parts of your photos, letting 
you perform traditional photo-editing tasks—like dodging and burning—with ease. (Local 
Adjustments are discussed starting on page 57.)

To switch between the different tabs, just click on the appropriate tab. While you work on an image, all 
of your settings in each tab are saved while you edit. When using Effects as a plug-in from Lightroom, 
Photoshop Elements, or Apple Photos, you can still move between the Effects and the Local tabs. 

NOTE: If you’re using ON1 Effects as a plug-in with Photoshop Smart Objects,  
all of your work will be re-editable, as long as you don’t add additional layers. 
(For more, see page 6)

To help you save time and create the looks that you love best, ON1 Effects has a robust preset system that 
lets you save settings made in any of the editing tabs—including local adjustments and masks—for applying 
to other photos.  (Presets are discussed in detail starting on page 32.)
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ON1 Effects Main Screen Overview

Effects provides you with an easy-to-use work space for editing your photos. Below is an overview of the 
main sections of the Effects window:

A.	Tool well: Tools for working within Effects.

B.	 Preferences/Help: Shortcuts to app preferences and help.

C.	 Presets/Filters panel: Tabs with list of presets by category and a list of all available filters. 

D.	Search: Searches presets and filters by name.

E.	 Preview Window: Displays the current photo in detail view.

F.	 Magnification Slider: Sets the preview magnification.

G.	Tool Options bar: Options and settings for currently selected tool.

H.	Preview option toggles: Compare (before/after) mode, show/hide mask, turn soft proofing and 
turn preview on or off.

I.	 Photo Information pane: Navigator, levels (histogram) and general photo information.

J.	 Edit tabs: Tabs for accessing Effects and Local Adjustments. 

K.	 Filter Stack: Where you add filters to apply to your photo. Click the Add Filter button at the 
top of the stack to add filters.

L.	 Reset bar: Reset all Effects settings (removes any applied filters or local adjustments), Cancel 
(closes the photo without saving), Done (applies edits, saves and closes photo).

M.	Output: Shortcuts for exporting and sharing the current photo.
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The left side of the window contains a Tool well, a Presets panel and a Filters panel. Click on the tab to 
switch between the different panels.

The right side of the screen contains three panes at the top—Navigator, Levels/Histogram and Info—and 
tabs for the two editing areas: Effects and Local. Clicking on a tab will bring up the options and settings for 
that area.

Navigating the Preview Window
ON1 Effects 2019 provides several ways to navigate and view your image in the Preview window:

• By default, your image is presented in Fit view, which displays your entire image within the 
preview area, and the Zoom tool is selected. Clicking on the image with the Zoom tool will 
zoom in to 100%, and the cursor will change to the Hand tool. You can move around your 
image by clicking and dragging in the preview area. Clicking once will take you back to Fit 
view.

• You can also zoom in and out via the View menu and the Navigator pane. The Navigator 
pane displays a bounding box around the current on-screen area; you can reposition what is 
displayed in the preview area by dragging the box around the pane. Clicking on one of the 
buttons at the bottom of the Navigator pane will automatically zoom to Fit, 100%, 50% or 
25% views. (The buttons are also in the Tool Options bar when the Zoom tool is selected.)

• When the preview zoom is larger than the viewable area, holding down the spacebar will 
display the Hand tool if any editing tool is selected. Clicking and dragging while holding the 
spacebar will reposition your image at the current view level.

Navigator, Histogram and Info Panes
At the top of the control panel on the right of the main window are the Navigator, Histogram, and Info 
panes. It contains three useful tools for inspecting and viewing details of your image.

THE NAVIGATOR PANE

This gives you a thumbnail view of your image. The white square 
region marks the image area that is visible in the preview pane. 
You can pan your image by clicking and dragging inside the 
square.

At the bottom of the Navigator pane are several zoom buttons 
representing percentage zoom views (100%, 50% and 25%). Click 
on one of the buttons to change the view.

Fit zooms to fit the current canvas size, while 100 zooms to 100%, displaying the actual pixels.
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THE LEVELS PANE

This gives you a color chart of the shadow, midtone and highlight 
areas based on the image RGB values. This is useful to show 
areas within the image that may be clipping. Clipping is when 
your image contains pure blacks or white and can signify loss of 
highlight or shadow detail.

The left side of the histogram represents the shadows, while 
the right represents the highlights. At the top of each end is a 
triangle. If the triangle is lit, there is clipping on that side of the histogram. If you click on the arrows, you 
will activate the clipping overlay on your image, which displays the areas that are clipped. Those areas with 
a blue overlay are pure black, while the areas with the red overlay are pure white. You can turn the clipping 
view off again by clicking on one of the triangles. You can also temporarily enable clipping view by holding 
down the J key at any time. The clipping view is useful when you are making adjusts to the brightness and 
contrast of your image.

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

THE INFO PANE

The Info Pane displays metadata for the currently selected image 
in a large, easy-to-read format. This metadata includes camera 
make and model; lens focal length; capture date and time; file 
type; GPS location data; ISO setting; shutter speed; aperture; and 
exposure compensation.

The Info pane also displays file-specific date, including name, 
color space, image dimensions and resolution. If any of the 
metadata fields are unavailable they will be left blank.

The clipping overlay can be a useful tool when editing. When it is turned on (via the Levels pane or 
View > Show Clipping), pure white areas of a photo will be shown in red, pure black areas will be 
blue.
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The Tool Well
Effects has 13 tools available for you when you are working on a photo, and are accessible via the tool well 
on the left side of the screen. Two tools—Crop and View—are self-contained within the tool icons. Others 
are nested within a tool group—Local, Mask, Refine, and Fix—and are accessible via the Tool Options bar at 
the top of the screen when you click on one of those tool icons:

• Crop Tool: Trims an image to your desired size or ratio. Shortcut key: C

• Adjustment Brush (Local group): Paints in or out local adjustments. Shortcut key: K

• Adjustable Gradient (Local group): Applies a selective gradient in local adjustment 
mode. Shortcut key: Shift+K

• Masking Brush (Mask group): Mask large similar areas quickly. (Includes Perfect Brush 
option.) Shortcut key: B

• Masking Bug (Mask group): Applies a selective gradient as a mask in any filter (or to the 
entire stack). Shortcut key: M

• AI Quick Mask Tool (Mask group): Create high-quality masks with only a few strokes as 
guidance. Shortcut key: W

• Refine Brush (Refine group): Lets you refine an existing mask’s edges, to help mask 
difficult areas, such as hair. Shortcut key: N

• Chisel Tool (Refine group): Removes fringes from the edge of a mask. Shortcut key: H

• Blur Tool (Refine group): Blurs the edges of a masked area to help it blend more 
naturally. Shortcut key: L

• Perfect Eraser (Fix group): Removes distractions like signs and power lines.  
Shortcut key: Q

• Retouch Brush (Fix group): Removes blemishes like dust spots and acne. (Includes 
Perfect Brush option.) Shortcut key: R

• Clone Stamp (Fix group): Paints over an area from a sample of another area.  
Shortcut key: S

• Zoom Tool: Adjusts the magnification of the image in the Preview area.  
Shortcut key: Z

To access a tool, simply click on the tool, or use the shortcut key attached to the tool. When selected, the 
cursor will change, and you will see a set of options for the tool in the Tool Options bar above the Preview 
window. If the selected tool is part of a tool group, you will see the other tools in that group, on the left 
side of the Tool Options bar.

CROP TOOL

To crop an image, select the Crop tool from the tool well. If desired, select any preset crop 
ratio you would like to use from the Options bar; the default is Freeform, which lets you crop 
in whatever size or ratio you would like. Adjust the corner handles of the crop tool overlay to 
get the area you wish. (The area outside the crop box appears darkened for guidance.) You can 

resize and move the image inside the crop box. When you are satisfied with your settings, press the Apply 
button in the Options bar or press Enter.
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To move the image inside the crop box, simply click and drag inside the box. You can also nudge the image 
using the arrow keys on your keyboard.

To resize the crop box, click and drag on any of the handles. Clicking on a corner handle allows you to adjust 
two sides at the same time; clicking on a side handle allows you to adjust that side. If you hold the Shift key 
down while adjusting the size, the box’s proportions are maintained. To rotate the crop box, move outside a 
corner until the tool changes to rotate.

To straighten an image, you can use the Leveling tool, which is found in the Tool Options bar when the Crop 
Tool is active. Click on it, and drag the tool across an element in your image that should be level.

NOTE: The Crop tool is disabled when you use Effects 2019 as a plug-in; you 
should use the host application to crop your photos. 

Crop Tool Options Bar:

• Preset pop-up: Lets you choose from Freeform or constrained preset ratios

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Leveling Tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Reset: Resets the crop area to the size of your original photo.

• Apply: Applies the crop.

ADJUSTMENT BRUSH (LOCAL GROUP)

The Adjustment Brush, which works within the Local tab (see Local Adjustments on page 
57), works like a standard brush tool, with adjustable sizes, feathering and opacity. You can 
paint an adjustment in or out via the Mode pop-up in the Tool Options bar, and adjust the size 
and feathering of the brush via the bar or with the bracket keys on your keyboard. The 
Adjustment Brush is especially powerful when used 

with the Perfect Brush option, represented by its icon at the 
right of the Tool Options bar.

The Perfect Brush option incorporates a color-based, self-
masking technology to help create precise selections and masks. 
When you turn the Perfect Brush option on, the Adjustment 
Brush collects the colors under the center of the brush and 
applies the effect only to those colors. This protects the 
adjustment from being applied across edges. An example of 
using the Perfect Brush would to darken the sky in an image, 

Perfect Brush options.
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but didn’t want to darken a group of mountains on the horizon.

The Threshold slider will allow you to control the balance between keep and drop colors, based on the area 
you are working on. For example you may want the Perfect Brush to be very precise and only paint away 
very similar colors, other times you want it to paint away a broad range of colors in the same neighborhood.

The Transition slider controls the feather of the Perfect Brush based on color. To create a soft edge, 
increase the transition amount. To create a harder edge, decrease the transition setting.

TIP: You can turn the Perfect Brush on and off using the Command-R keyboard 
shortcut (Control-R on Windows). You can also temporarily lock the color to 
remove by holding down the Control key (Windows) or the Command key 
(Mac). This is useful when brushing through areas with a lot of openings like 
tree branches.

Adjustment Brush Tool Options

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways:

• Use the Size pop-up in the Tool Options bar.

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Use your mouse’s scroll wheel (this option can be set in Effects 2019’s General 
Settings tab).

• Use your Wacom pressure-sensitive tablet.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and pressing the right or left bracket keys 
on your keyboard.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the size of the brush several ways:
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• Use the Opacity pop-up in the Tool Options bar.

• Press the Option (Mac) or Alt (Windows) key on your keyboard and press one of the 
number keys. Each number represents an opacity percentage from 10% (1) to 90% (9); 
0 represents no opacity.

• Use your Wacom pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your 
mask. While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.

• Perfect Brush: The Perfect Brush option incorporates a color-based, self-masking technology 
to help create precise selections and masks. When you turn the option on—by clicking on the 
Perfect Brush icon in the Tool Options bar—the Masking Brush collects the colors under the 
center of the brush and applies the effect only to those colors. This protects the adjustment 
from being applied across edges, such as tree branches. 
Further settings for the Perfect Brush can be found by clicking on the gear icon in the Tool 
Options bar. There, you can set the following options:

• Color Threshold: This option lets you control the balance between keep and drop 
colors, based on the area you are working on. 
For example, you may want the Perfect Brush to 
be very precise and only paint away very similar 
colors, while at other times you want it to 
paint away a broad range of colors in the same 
neighborhood.

• Transition: This slider controls the feather of the 
Perfect Brush based on color. To create a soft 
edge, increase the transition. To create a harder 
edge, decrease the transition amount.

Wacom Support

Effects supports pressure-sensitive tablets from Wacom with the Adjustment Brush. When you use 
the Masking Brush you can enable pressure sensitive controls for the brush size, brush opacity, or both 
simultaneously. To turn this support on, click on the gear icon in the Tool Options bar. You can activate 
pressure sensitivity for both size and opacity by clicking the appropriate buttons in the drop-down menu.

Detailed information on using Local Adjustments in ON1 Effects 2019 starts on page 57.



ON1 Effects 2019 from A-Z	 Part 2: Working in Effects	 22

ADJUSTABLE GRADIENT TOOL (LOCAL GROUP)

The Gradient Adjustment tool is very similar to the Masking Bug, but it is solely for use within 
the Local Adjustments tab. It lets you create a linear or radial gradient mask across part of your 
image, The gradient mask goes from dark to light in tone, applying more of the adjustment 
where the gradient is lighter, and less of the adjustment where the gradient’s tone is dark. The 

most common use of gradient masks is to darken the sky in an image, while preserving the brightness of the 
foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Adjustable Gradient Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the Gradient Adjustment 
tool (top down, bottom up, left and right, and circular vignettes), and changes the current bug 
(if there is one) to match the preset.

• Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial shapes: 
Center, which puts the light tones at the center and the 
dark tones on the outside of the mask, and Edges, which 
sets the gradient in the opposite direction.

• Opacity: Sets the maximum opacity or density of the 
mask.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This 
removes all gradients and clears any brushing that has 
been done.

Manipulating Gradient Masks

Once you’ve added a gradient to an image, you can modify it by 
accessing the parts of the gradient overlay:

• To move a gradient, click on the big circle at the center of 
the gradient and drag.

• To resize a radial gradient, click and drag on the solid 
line.

The Edges gradient shape lets you create such 
masking effects as customized, adjustable 
vignettes.
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• To adjust the feather (hardness) of the mask, click and drag along the dashed line.

• To rotate the mask, click the smaller circle near the gradient center and drag.

Detailed information on using Local Adjustments in ON1 Effects 2019 starts on page 57.

MASKING BRUSH (MASK GROUP)

The Masking Brush is one of two tools used for masking filters in Effects. When you select the 
Masking Brush, your cursor changes to look like two concentric circles, one representing the 
hard, inner edge of the brush, and soft outer, feathered edge of the brush. At the center of the 
brush is either a plus or minus. The plus means that you are painting “in” a filter’s effect, while 

minus means the brush mode is set to paint the filter “out.”

Masking Brush Tool Options

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the option (alt) key temporarily.

NOTE: If you would like to invert the mask (turn it from black to white), in 
order to paint a filter’s effect into your image, select the Masking Brush tool, 
then choose Invert Mask from the Mask menu.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways:

• Use the Size pop-up in the Tool Options bar.

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Use your mouse’s scroll wheel (this option can be set in ON1 Effects 2019’s General 
Settings tab).

• Use your Wacom pressure-sensitive tablet.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and pressing the right or left bracket keys 
on your keyboard.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
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paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the size of the brush several ways:

• Use the Opacity pop-up in the Tool Options bar.

• Press the option (Mac OS) or alt (Windows) key on your keyboard and press one of the 
number keys. Each number represents an opacity percentage from 10% (1) to 90% (9); 
0 represents no opacity.

• Use your Wacom pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your 
mask. While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.

• Perfect Brush: The Perfect Brush option incorporates a color-based, self-masking technology 
to help create precise selections and masks. When you turn the Perfect Brush option on—by 
clicking on the Perfect Brush icon in the Tool Options bar—the Masking Brush collects the 
colors under the center of the brush and applies the effect only to those colors. This protects 
the adjustment from being applied across edges, such as tree branches. Further settings for 
the Perfect Brush can be found by clicking on the gear icon in the Tool Options bar. There, 
you can set the following options:

• Color Threshold: This option lets you control 
the balance between keep and drop colors, 
based on the area you are working on. For 
example, you may want the Perfect Brush to be 
very precise and only paint away very similar 
colors, while at other times you want it to 
paint away a broad range of colors in the same 
neighborhood.

• Transition: This slider controls the feather of the 
Perfect Brush based on color. To create a soft 
edge, increase the transition. To create a harder 
edge, decrease the transition amount.

TIP: You can turn the Perfect Brush on and off using the Command–R (Mac 
OS) or Control-R (Windows) keyboard shortcut. You can also temporarily lock 
the color to remove by holding down the Command (Mac) or Control (Windows) 
key. This can be useful when brushing through areas with a lot of openings like 
tree branches.
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Wacom Support

ON1 Effects supports pressure-sensitive tablets from Wacom with the Masking Brush. When you use 
the Masking Brush you can enable pressure sensitive controls for the brush size, brush opacity, or both 
simultaneously. To turn this support on, click on the gear icon in the Tool Options bar. You can activate 
pressure sensitivity for both sizer and opacity by clicking the appropriate buttons in the drop-down menu.

MASKING BUG (MASK GROUP)

The Masking Bug is used for blending filter layers by creating radial, gradient and reflected 
gradient mask shapes quickly. It works in a similar manner to the Adjustable Gradient tool in 
the Local Adjustments pane. The mask goes from dark to light in tone, applying more of the 
adjustment where the gradient is lighter, and less of the adjustment where the gradient’s tone 

is dark. The most common use of gradient masks is to darken the sky in an image, while preserving the 
brightness of the foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a filter, click on the Masking Bug in the tool well, then click in the image 
roughly where you wish the gradient to go. You’ll see 
the outline of the gradient, which is called a bug. You 
can use the handles on the bug to move your gradient 
around, increase or decrease the length of the gradient, 
or rotate it.

You can change the gradient shape via the Tool Options 
bar: in addition to the standard dark-to-light horizontal 
gradient, you can also create a circular gradient and a 
reflected gradient, which is like the horizontal gradient, 
but goes from black (no effect) at the outer edges to 
white (full effect) in the center.

Masking Bug Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the tool (linear top down, 
linear bottom up, left and right, and circular vignettes), and changes the current bug (if there 
is one) to match the preset.

• Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial shapes: Center, which puts the light tones at 
the center and the dark tones on the outside of the mask, and Edges, which sets the gradient 
in the opposite direction.

• Opacity: Sets the maximum opacity or density of the mask.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

In this image, a Dynamic Contrast filter has been applied in Effects. 
To keep the effect out of the clouds, a Masking Bug has been added.
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Manipulating a Gradient Mask

Once you’ve added a gradient to an image, you can 
modify it easily by accessing the following parts of the 
gradient overlay:

• To move a gradient, click on the large circle at 
the center of the gradient and drag.

• To resize a radial gradient, click and drag on the 
solid line.

• To adjust the feather (or hardness) of the mask, 
click and drag along the dashed line.

• To rotate the mask, click on the smaller circle 
near the center of the gradient and drag.

TIP: To see the mask created by the Masking Bug, and the range of black to 
white tonality, choose Show Mask from the View menu. You can choose either 
a red overlay, which presents the mask over your image, or grayscale, which just 
shows the mask as black to white tones.

Working with Multiple Masking Bugs

You can have up to six Masking Bugs per layer. (Each bug is re-editable when you’re using the Smart Filters 
option from within Photoshop—see Using Photoshop on page 6 for more.)

To add another Masking Bug, press the Add button or click outside of the current bug while the Masking 
Bug tool is selected.

Only one Masking Bug may be adjusted at a time. You will see the overlay controls for the active bug while 
your mouse is over the preview area. Inactive bugs are marked with a small circle; to select an inactive bug 
clicking on this small circle marker.

Masking Bugs are subtractive. Each bug hides more and more of the current layer. When Masking Bugs 
overlay each other they may hide more of the layer too. You can always use the Masking Brush to over-ride 
and paint areas back in hidden by the Masking Bugs.

AI QUICK MASK TOOL (MASK GROUP)

Powered by machine learning, the AI Quick Mask tool can create high-quality masks with just 
a few strokes as guidance. To use it, mark areas you want to keep in green and areas you want 
to drop in red. Then using its artificial intelligence, the tool analyses the color, tone and texture 
of the marked regions to learn what you want to mask and automatically finds the edges and 

creates the mask for you.  

The following page details the steps to use the AI Quick Mask tool.
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1.	 First, you need to give the tool guidance as to what you want to keep and drop. This is done 
by loosely painting over the regions in your photo. There is no need to precisely paint the 
entire photo: just a few representative strokes of red and green are all that are needed. Paint 
with Drop mode—which is the default brushing mode—over the portions of your image that 
you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to 
Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas 
you want to keep. These strokes will show up as green.

2.	 Now press the Apply button in either the Tool Options bar or the AI Quick Mask HUD. This 
will generate a temporary mask to preview the results. Areas that are filled with red will 
be masked out, areas in green will remain. Keep in mind the edges will appear rough at this 
point and will be smoothed out when you generate the final mask.

Using the AI Quick Mask tool is easy: paint over the areas you wish to remove with the Drop option (shown in red), then paint 
loosely over the areas you wish to keep with the Keep option (shown in green).

Clicking on the Apply button in the HUD (or the Tool Options Bar, if you’ve hidden the HUD) will display a temporary mask. From 
here, you can click the Done button to generate the final mask, or you can use the Keep and Drop modes to further refine your 
mask.



ON1 Effects 2019 from A-Z	 Part 2: Working in Effects	 28

3.	 If the preview results look good, press the Done 
button in the Tool Options bar or the AI Quick 
Mask HUD. If there are areas that are incorrect, 
you can continue to improve the results by adding 
more Keep and Drop strokes. Press Apply each time 
to preview the improved results. When you press 
Done, the edges are refined with high precision 
and ON1 Effects switches to the Refine Mask tool, 
which you can use over difficult, semi-transparent areas—like tree branches—if necessary.

NOTE: The AI Quick Mask tool resets any existing mask on an adjustment 
layer or filter.

AI Quick Mask Tool Options Bar 

• Mode: This controls keeping (painting green) or dropping (painting red). Green areas are 
protected in your mask, and are the areas of a layer or filter that will remain. The areas 
marked in red will be removed or masked. In your layer these areas will become transparent. 
On a filter in Effects, these areas will have the filter’s effect removed.  
	 You can tell your current mode by looking at the plus or minus icon in the center of the AI 
Quick Mask brush. If the icon is minus, you are painting drop (red) areas; if the icon is a plus, 
you are painting keep (green) areas. You can change the mode in the Tool Options bar, or by 
pressing the Shift-X key, or by holding down the Option (Alt) key temporarily. 

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways: 

• Use the Size pop-up in the Tool Options bar. 

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ . 

• Use your mouse’s scroll wheel (this option can be set in ON1 Effects 2019’s General 
Settings tab). 

• Use your Wacom pressure-sensitive tablet. 

Further settings for the AI Quick Mask tool can be found by clicking on the gear icon in the Tool Options 
bar. There, you can set the following options: 

• Pressure Adjusts Size: This option lets you control the 
size of the brush using a pressure sensitive tablet. 
The harder you press, the larger the brush becomes 
up to the current setting of the size slider.  

• Refine Edge: This applies the Refine Mask Brush 
automatically to the edge of the resulting mask, 
creating a more natural transition. This is on by 
default and recommend for most photos.

The AI Quick Mask HUD.
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• Show HUD: This displays the AI Quick Mask HUD dialog (shown on the right) that provides 
guidance on how to use the tool.

• Overlay: Sets the transparency of the red and green mask overlays on top of your image. A 
setting of 100 displays only the mask; the default setting is 50.

REFINE BRUSH (REFINE GROUP)

This tool cleans up intricate areas and the borders along a mask, and is helpful for cleaning up 
a mask created with the Masking Brush. For example, when you wish to apply an effect to a 
subject, and there are areas such as hair, or tree branches that are difficult to remove with the 
Masking Brush.

To use the Refine Brush, select the tool in the Options bar and paint along the edges where you would like 
the mask to be refined. The brush strokes are displayed as a red overlay, and when you let up off the mouse 
button, ON1 Effects 2019 will work to make making the mask edge more defined, improving the overall 
mask.

Refine Brush Tool Options

• Mode: Controls the refinement mode, either Paint Out, which always refines to remove from 
the mask, Paint In, which always refines to add to the mask, or Auto, which does both at the 
same time. Paint Out is recommended in most cases.

• Size: This slider adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results.

• Pressure Adjusts Size (gear icon): If you have a Wacom tablet you can control the size of the 
brush with pressure when this setting is turned on.

CHISEL MASK TOOL (REFINE GROUP)

The Chisel tool, accessible vie the Refine Tool Options, bar works to remove fringes or 
halos along the hard edges of a mask; just click and drag along the edges of a mask you wish 
to refine. Fringes are common when the background to be removed is brighter than the 
foreground. The chisel works like a chisel or plane in a wood shop: It removes just a sliver along 

the edges, and, because it only works on the edges, you don’t have to be too careful when using it.

Chisel Mask Tool Options

• Mode: Select remove or add from the current mask.
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• Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. 
The size of the chisel does not affect how much is chiseled off.

• Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-click on the Chisel tool icon in the Tool Options bar to apply the 
chisel to the entire mask.

BLUR MASK TOOL (REFINE GROUP)

The Blur Mask tool, the final tool in the Refine group, softens edges of the mask where you 
paint; all you need to do is run the tool over the edges you wish to blur. Softening the edges on 
blurred or semi-transparent subjects like hair can make them blend with a new background in a 
more realistic manner. 

Blur Mask Tool Options
• Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs 

and lightens the mask; Add blurs and darkens the mask; Normal blurs both light and darks.

• Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The 
size of the brush does not affect the blur amount.

• Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-click on the Blur tool icon in the Tool Options bar to apply the blur 
to the entire mask.

PERFECT ERASER (FIX GROUP)

The Perfect Eraser can be used to remove distracting elements and blemishes from your image. 
It uses a content-aware algorithm that replaces the pixels with a natural-looking result within 
the boundaries that are painted.

Using the tool is easy: click on it in the Fix group’s Tool Options bar, and paint over the area you wish to 
remove. Make sure you cover the entire area. A red overlay appears where you paint. If the first attempt 
does not give you a perfect result, simply paint over it again and it will improve with each pass. You can also 
fine tune the area after applying the Perfect Eraser by using the Retouch Brush (see below).

Perfect Eraser Options
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The Perfect Eraser’s Tool Options bar consists of two options; one for brush size, the other to turn on 
Wacom tablet support.

The default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller by clicking 
on the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your keyboard. 
The maximum brush size is 500 pixels. If you have a Wacom pressure-sensitive tablet, select the Pressure 
Adjusts Size button in the Options bar.

RETOUCH BRUSH (FIX GROUP)

Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the brush 
on areas that contain spots or other imperfections, such as acne, sensor dust, power lines and 
more. The tool looks at the neighboring areas in your image and fills in the brushed area with an 
area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush 
strokes. If you dab with the Retouch Brush and don’t like the results, use the Undo command and try using 
a smaller brush or vary your brush stroke and try again. The Retouch Brush is also great for retouching skin.

Retouch Brush Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: Click on the button to activate the Wacom sensitivity controls.

CLONE STAMP (FIX GROUP)

Use the Clone Stamp tool for replacing an area of the image with a sample area from a 
different part of the image. Hold down the Option (Mac) or Alt key (Windows) and click the 
area you want to clone from. Then click and drag on the area you want to clone over and it will 
clone from the point you selected.

Clone Stamp Tool Options:

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
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imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet, you can adjust the size of 
the brush according to the pressure. Click the button to activate.

ZOOM TOOL

This tool, which is the default tool selected when you open an image in Effects, adjusts the 
magnification of the image in the Preview window. With the Zoom tool selected, click in the 
Preview window to zoom in and center the image at the location clicked.

You can also double-click the Zoom tool in the Tool well to set the image to 1:1 (or 100%) magnification 
view, which shows every pixel. This is best when examining small details.

Presets
Presets are a fast and easy way to get consistent results when editing a 
group of images, as well as help you hone your own photographic look. 
Presets are stored “recipes” that include a set of Effects adjustments, 
and can easily be applied to images with ease.

ON1 Effects 2019 comes with more than 200 built-in presets, in more 
than a dozen categories, ranging from landscapes to portraits, color 
grading, film looks and much more. You can also create your own 
presets, or import presets from other ON1 users and photographers.

You can create presets that apply Effects settings and local adjustments 
that use the Adjustable Gradient tool, and any combination of these.

Presets do not store crop settings, retouching information, or brush 
masks. Masks created with the Masking Bug, or with the Adjustable 
Gradient tool can be stored in a preset, however.

USING A PRESET

To apply a preset to an image, click on the Presets panel. There you will 
see any built-in presets supplied by ON1—ordered by category—as well 
as any presets you might have created or installed yourself. Clicking on a 
category name will open it and display any presets within that category, 
each with a tiny thumbnail showing your selected image with that preset 
applied to it (shown on the following page). To change the size of the 
thumbnails in the Presets panel, select the Browser Mode option from 
the View menu and choose One, Two or Three Column View.

If you’d like to see a larger representation of what your selected photo will look like with a category’s 
presets, click on the Quick View Browser icon in the category’s title bar. That will display a window over 
the entire Effects 2019 interface with all of the presets in that category. (Press the Escape key to close the 
Quick View Browser.)

The Preset panel, in its default (closed) 
view. As you hover over a category, the 
Quick View Browser icon appears on the 
left side of the category’s name. Clicking on 
that icon will open a full-screen window 
showing your photo with that category’s 
presets applied to it. Note that you can also 
create subcategories of presets. (See 
Organizing Presets on page 11 for 
more.)
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To apply a preset to a photo, simply click on the preset in either the Category mini-browser or in Quick 
View mode. Presets are not cumulative; after you’ve applied one preset, clicking on another preset will 
remove the previous one and apply the new one.

Once you’ve applied a preset, you can still make changes to any of the panes and settings, add or remove 
adjustments, switch to another preset, perform retouching tasks, or more. 

If you don’t like a preset, clicking on another one will replace the settings of the previous preset with the 
settings of the new preset. To remove a preset entirely, choose one of the reset options from the Settings 
menu, or remove the individual settings from the appropriate panes in Effects. (The latter approach is 
recommended if you have created masks or local adjustments that you wish to preserve.)

TIP: If you hover over a preset’s thumbnail in the browser, you’ll see a heart 
icon. Clicking this will add that style to your Favorites, which resides at the top 
of the Presets panel. To remove a favorite, click again on the heart icon.

INSERTING PRESETS
When you click on a preset, Effects’ default behavior is to remove any 
existing adjustments and apply the newly chosen preset to your photo. 
Sometimes, however, you would like to add a preset on top of your 
adjustments. To do this, open the Presets pane, right-click on the preset 
you wish to add, and choose Insert Preset from the pop-up menu. This will 
add the preset’s filters above the currently selected filter pane and will 
preserve any edits you made in the Local Adjustment tab. 

Clicking on the Quick View Browser icon in the Panels pane (or choosing Open Quick View Browser from the Window menu) will open a full-screen representation 
of that category’s presets, giving you a larger representation of how that preset will look when applied to your image.
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SAVING PRESETS

Once you have a group of edited settings that you wish to save, go to the 
Settings menu and select Save Preset. The New Preset dialog will appear, 
with options for which module’s settings you wish to save, naming the 
preset, and adding it to an existing or new category.

If you have applied a preset to an image, and subsequently updated any 
of the edit settings (or add or remove adjustments), you can update the 
preset with the new settings by choosing Update Preset with Current 
Settings from the Settings menu. This will only change the preset in your 
app; any images that had the old version of the preset will keep those 
settings unless you reapply the preset. (You can also update a preset by 
right-clicking on the preset in the Preset Browser.) 

If you would like to create a new preset category, choose Add New 
Category from the category pop-up. 

MANAGING PRESETS AND CATEGORIES

You can perform a variety of operations on presets and preset categories, including importing and 
exporting presets (individually or by category), deleting individual presets, and hiding categories.

Importing & Sharing Presets

You can import presets you have downloaded from the ON1 website or other source. Some files will be 
individual presets, while others might be preset “packs,” which will include more than one preset.

A preset will have an ‘.ONP’ extension, while a preset pack has an ‘.ONPreset’ extension; all you need to do 
is double-click on the file—or choose Import Preset from the Settings menu—and Effects 2019 will ask you 
to pick a category where you wish to place the preset or pack, and it will copy the presets into the app. You 
can delete the downloaded files, if desired.

To export an individual preset, click on it and choose Export preset from the Settings menu.

Deleting presets

To remove a preset if you no longer want to have access to it, follow these steps:

1.	 Select the preset you wish to remove in the Preset panel.

2.	 Select Delete Preset from the Settings menu.

(You can delete any preset, including the presets that came pre-installed with ON1 Effects. If you think you 
might wish to save a preset, export it first, then delete it.)

With the Save Preset dialog box, you can 
save your Effects settings, and any 
gradient masks, Local Adjustment 
settings that used the Adjustable 
Gradient tool, as well as any text blocks. 
(The Develop Settings option is not 
available in ON1 Effects 2019, and is 
grayed out.)
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Managing categories

In addition to creating your own preset categories, which get 
displayed in the Presets pane, you can also perform other operations 
on categories, including deleting, renaming or exporting. These 
options are all available via the Preset Category pop-up menu, which 
is available when you hold right-click on a category name:

• To remove a category—and its presets—from the Presets 
panel, choose Delete Category from the pop-up. (You can 
restore all of the hidden preset categories in the General tab of the Preferences window.)

• Choose Rename category if you wish to change the name of the category.

• To export a category and all of the presets within it as an ONPreset pack, choose Export 
Category from the pop-up menu.

TIP: Many preset management options can also be performed by clicking on a 
preset in the Preset panel and right-clicking on the preset. This is helpful if you 
want to update, export or rename a preset without applying it to an image.

Nesting presets

To help manage large groups of presets, Effects’ Extras Manager lets you nest preset categories. See 
Organizing Presets on page 11 for details on how to create and manage preset category subfolders.

SOFT PROOFING

ON1 Effects’ soft proofing feature lets you see how a 
photo will look when printed, using the color profiles that 
get installed with your printer. Soft proofing helps you 
determine where there might be issues when you print, 
so that you can adjust your tone, color and effects to give 
you a print that is closer to your editing vision.

Normally, when you’re viewing an image in Effects, you 
are viewing it through the lens of your monitor’s display profile. The color gamut of your computer’s display 
is wider than that of most photo printers, which means that some colors you are able to view on-screen are 
not reproducible when you print. When this happens, the color profile conversion that happens in the print 
engine will cause substitutions of colors that the printer cannot print to the closest color that it can. This 
means that your image could have subtle (or broad) shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or by clicking on the soft proofing icon to the left of the 
Preview button at the bottom center of the main Effects window. The background of the main preview 
window will change to approximate the color of the paper you’re profiling. 

Right-click on a preset category to get the 
category pop-up menu.

Effects’ soft-proofing options are located in the View menu.
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Additional soft proofing options are available underneath the Enable Soft Proofing command in the View 
menu. The options are as follows:

• Gamut warning: When checked, this displays 
colors in the image (via a red overlay) that 
don’t correspond to the current printer profile 
being soft proofed.

• Profiles: The Profiles submenu lists the 
currently available printer profiles. Choosing 
one will change the on-screen display to use 
that profile.

• Intent: Effects offers two different rendering 
“intents” when soft proofing, which are used 
to convert the color from display to print. 
Perceptual shrinks the color gamut during 
the conversion, which works to preserve the 
relationship between colors in the image. 
The other intent type, Relative, only converts 
colors that are outside the current color 
gamut, but this can sometimes cause two 
colors, one in gamut, and one outside, to be 
identical after conversion.  
	 Neither rendering intent is perfect or 
desired; it often is a matter of the makeup of 
the image, your editing intent, the paper being 
printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and 
Perceptual, seeing which gives you a better 
print.

• Simulate Paper and Ink: Turning this setting on 
will cause Effects to use the white point for 
the chosen paper type (instead of the white 
point of your monitor), and the paper’s actual 
black density (instead of the display’s black 
point). If you’re trying to match a print, you 
will usually want this setting turned on.

Adjusting images with soft proofing is often a bit of trial 
and error. It’s easy to get caught up in eliminating out-
of-gamut colors, but most modern photo printers—both 
home printers and online print services—do a pretty good job of approximating colors properly. 

The biggest thing you want to be looking for when viewing a soft proof is tone, contrast and color accuracy 
between screen and print. When using a home printer, use test prints to hone in on the right mix of Effects 
module adjustments. 

These three screen shots show the results of soft proofing options, 
as viewed in the Effects module. The top image is with soft 
proofing off (and is using the display color profile). The middle 
image is with soft proofing turned on, and using a printer profile for 
Epson’s Exhibition Fiber Paper. The bottom image has the Gamut 
warning turned on; out of gamut colors are highlighted by the 
bright red overlay.
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Filters
The Effects filter stack is quite flexible, with numerous options that you can apply to a photo, including:

• You can add filters in any order (even multiple instances of the same filter).

• Move filters up and down in the stack.

• Add blending options to all or some of the filters and set the opacity of each filter individually.

• Create complex masks for each filter you add, letting you selectively apply a filter to specific 
portions of an image.

Filters are the building blocks of Effects’ editing power. Each filter is an adjustment type, much like the 
basic adjustment panes inside Develop, but Effects filters have much more functionality than the Develop 
panes. Each filter is like a movable, editable layer over the base image you are working on. You can use 
Effects’ masking tools to apply a filter to only part of an image and can change the blending mode (and 
opacity of the filter) to alter the way the filter interacts with those above and below it in the stack.

Effects has 27 filter types, added either by the Add Filter button found at the top of the Effects tab, or via 
the Filters pane on the left side of the window. You can apply filters in any order, and you can have more 
than one instance of a filter in the stack. (This can be helpful when you are creating complicated masks on 
an image and wish to apply a filter differently in parts of the image.)

FILTER OVERVIEW

Each filter pane has a different set of adjustment options 
and controls, depending upon the filter you choose, but 
every filter pane has the same five sections:

A.	Filter on/off button (left); Show/Hide Mask (right)

B.	 Displays blending mode options (left); Resets filter 
settings (middle); Deletes filter from the stack 
(right).

C.	 Filter opacity setting.

D.	Styles pane for filter presets.

E.	 Control area for adjusting that filter’s specific 
settings (dependent upon the filter chosen).

APPLYING FILTERS WITH THE ADD FILTER BUTTON

If you click the Add Filter button at the top of the Effects tab, the Filters window opens up, with a list of all 
27 filters. If you run your cursor over a filter name, the right side of the window will have a small before/
after thumbnail, a short description, and a list of keywords that relate to that filter. To add a filter, click once 
on the filter name, and it will add it to the stack, above the currently selected filter. If there aren’t any filters 
in the stack, the new filter will be at the top of the stack.

Overview of a filter—in this case, the Cross Process filter—
inside Effects.
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If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. Effects will narrow the search to those filters that match your terms.

APPLYING FILTERS WITH THE FILTER BROWSER

In addition to the Filters window, Effects has a Filter panel on the left side of the 
screen. This panel lets you browse all of the filters, and will display previews of 
those filters with the available styles for that filter. To choose the Filters panel, 
click on the Filters tab. A list of the filters will appear; clicking on a filter will 
display thumbnails of your image with that filter’s available styles. To choose one, 
click on the style, and Effects will add that filter to the Overall Settings pane. 
Note that this will replace the currently selected filter in the stack; to add a new 
one on top of the stack, click the Add Filter button at the top of the Effects tab 
on the right, then choose a filter from the list.

To change the size of the thumbnails in the Presets panel, select Browser Mode 
from the View menu and choose One, Two or Three Column Thumbnail View.

If you’d like to see a larger representation of what your selected photo will look 
like with a filter’s styles, click on the Quick View Browser icon in the category’s 
title bar. That will display a window over the entire window with all of the styles 
in that category. (Press the Escape key to close the Quick View Browser.)

If you hover over a filter style’s thumbnail in either the Filter Browser or the 
Quick View Browser, you’ll see a heart icon. Clicking the icon will fill the heart 
in and add that style to your Favorites category. This category resides at the top 
of the filter list, and contains all filter styles you have selected as a favorite. To 
remove a favorite, open the Favorites category, and click again in the heart icon.

To apply a filter style to a photo, simply click on the style in either the Filter 
Browser or in the Quick View Browser.

Searching for filter styles inside the Filter Browser

To search for styles inside the Filter Browser, type in the name you’re looking for in the search field at the 

The Filters window opens when you click on the Add Filter button at the top of the 
Effects tab.
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bottom of the panel. The search results will appear in a new sub-folder called search results, which will be 
selected automatically.

WORKING WITH FILTER PANES

By default, the filter stack is empty, although, if you have applied a preset, you will see those filters in the 
stack. Clicking on the button in the top left corner of the filter pane will turn that effect on or off, which 
can be helpful if you want to see the effect in the context of other edits you have made. If you don’t like 
the effect, click on the ‘X’ icon in the pane’s title bar to get rid of it. The Reset button, which is next to the 
Delete button, is represented by ‘⟲’ and will reset that pane’s settings to their default.

To move a filter up or down in the stack, click on the pane’s title bar and drag it up or down. A heavy white 
line will appear between panes as you drag; let go of the mouse at the location you wish the filter to go.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/Show 
link is visible when you move your cursor over the title bar, but the entire title 
bar is clickable). If you don’t want to have to scroll up and down the filter stack 
when you have a lot of open panes, go to the Window menu and choose Solo 
Mode. This will leave the current pane open, and will hide all the other panes. 
Clicking on another pane will open that one and collapse the previous one.

STYLES

Most of the panes in Effects have a set of built-in styles in 
the top part of the pane. Styles are like preset adjustments 
for a pane: they provide a group of settings to help you get 
started in the pane, or to apply a specific effect.

You use a style by clicking on the style’s icon in the pane, 
and then can adjust the sliders as desired to get the right effect for your photo.

You can save your own settings as a style. Simply click on the More icon on the far right side of the styles 
list for that pane, then choose Save New Style from the pop-up. Name your style, and it will then be 
added to the top of the More menu. To apply a saved style, choose the style from the More pop-up menu. 
To adjust the settings for a saved style, apply it, make any changes you would like to the sliders or other 
options, then right-click on the More pop-up and choose Update Style with Current Settings from the 
menu.

FILTER MASKS

Every filter (and local adjustment) has a mask associated with it, which lets you apply that filter’s effect to 
specific areas of an image, using the Masking Brush (or the Local Adjustment Brush and Gradient, when 
working in the Local tab) and Masking Bug tools. By default, the mask is white, which means that the effect 
is visible in every part of the image. Using the Masking Brush, for example, you can ‘paint out’ the effect in 
areas that you wish not to be affected by the filter. Alternatively, you can invert a filter’s mask and choose 
to ‘paint in’ the filter where you would like it to be.

Styles for the Photo Filter.
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When you add a filter, the mask is technically hidden. You can add one by either selecting and using one of 
the two masking tools, or by clicking the Show/Hide Mask icon in the title bar of the filter pane (this icon 
will initially be represented with a plus sign in the middle of it). When you add a mask in either way, the 
contents of the Show Mask icon will represent the mask on that filter layer.

Effects has two options for viewing the contents of a mask: either as a red overlay on top of your image 
(the default) or a view only of the mask itself, represented as grayscale. These options are available from 
the Mask menu; select Show Mask to see the mask, while the View Mode option lets you switch between 
the two modes. (Effects will remember the previous settings.)

The Mask section of any filter or local adjustment has the following contents, as shown below (using the 
Tone Enhancer effect as an example):

A.	The Show/Hide Mask icon, which displays the 
contents of the current mask. The default mask 
contents are white when you add an effect, and 
black when you add a local adjustment layer.

B.	 Sets the overall opacity of the mask.

C.	 Larger display of the current mask, with buttons 
to invert, reset, copy, paste, and view/hide the 
mask contents. The Lumen button creates a 
luminosity mask of the image.

D.	Density adjusts the overall mask density from 
black (100) to white (0). Feather blurs the mask.

E.	 The Levels and Window settings let you adjust 
the black and white points of the mask, fine 
tuning them in different ways.

F.	 The Color Range option lets you choose a color 
(selected via the dropper tool), and make or tune 
the mask based on the range of the color selected.

Luminosity Masks

A luminosity mask is a specialized mask type you can create anywhere you can create a mask inside Effects. 
This mask uses the brightness (or luminance) values in your image to let you target specific tonal ranges 
with an effect (or to hide the effect from those tones). It is ideal for subtle enhancements to very specific 
areas of an image.

To add one of these masks, click on the Lumen button in the Mask options area or choose Create 
Luminosity Mask from the Mask menu. If you view the mask, you will see that it looks like a black-and-
white version of your image. With a luminosity mask, your effect will be applied in an increasing amount 
depending upon the brightness value of the pixel underneath: if the pixel is black, none of the effect will be 
applied; if it is white, it will be entirely applied; for all other tones, the effect will get applied as a percentage 
of the pixel’s brightness, from 0 (white) to 100 (black).

You can use the Levels or Window controls to further target tones with your luminosity mask. The Levels 
setting lets you set the black (left triangle) and white (right) points of the mask, with the midpoint, or 
gamma, setting being adjusted by the middle triangle. This lets you refine the mask to focus on narrow 

Overview of the Mask Options section of a filter pane in Effects, 
showing a luminosity mask. Mask Options is also applicable 
when working in the Local Adjustments tab, or on a layer in the 
Layers pane.
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bands of luminance values in an image; for example, if you wanted to focus an effect on the midtones, 
bringing the white and black points into the middle of the Levels slider, and adjusting the midpoint, will help 
achieve this much quicker than you could with the Masking Brush.

The Window slider is similar to the Levels slider, in that it works like a black point slider from both sides. 
When you move the right and left triangles, all of the tonal ranges outside the points will be black, leaving 
those areas affected that are within the ‘window’ of the mask. For example, if you wanted only the shadows 
in your image to have an effect, you would move the right slider over towards the left by about two-thirds.

Color Range selections

The Color Range option lets you create a mask using a specific color, either one inside your image, or one 
via your system’s color picker. To use this option, click the On button next to the Color Range section, and 
click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the 
slider to expand or contract your mask based on that color: lower numbers means that fewer colors will be 
selected, higher numbers mean that more.

Masking tips

Here are a few tips for working with the various options in the Mask pane:

• You can use multiple masking tools to create and modify masks. For example, you can start 
with a luminosity mask, adjust the tonal range of the mask with the Levels or Window sliders, 
and then further refine your mask with the Masking Brush or Masking Bug. A luminosity mask 
always overrides the current mask, however, so you should start there.

• Use the Feather slider to blur a mask, smoothing transitions between masked and unmasked 
sections.

• Lowering the Density slider can help intensify an effect after you’ve created a mask. Think of 
it like a ‘reverse fade’; at the default setting of 100, all of your mask is viewable, and at 0, the 
mask is entirely white.

• Because it can sometimes be helpful to use the same mask on different filters, use the Copy 
button to grab the contents of a mask from one filter and the Paste button to paste that onto 
the mask of another filter.

DELETING A FILTER

You remove a filter by selecting it and pressing the ‘X’ icon to the right of the filter’s pane.

FILTER OPACITY

Every filter has an opacity setting, which effectively adjusts the strength of the filter. The Opacity slider, 
which is found at the top of each filter’s pane, ranges from 0 (no effect) to 100 (full effect). What this 
means is that at 100, all of the filter is applied to the image in the stack. At 50, the filter strength is half, and 
the effect is much less strong. Playing with a filter’s opacity can often help soften an effect in a way that 
you wouldn’t be able to get otherwise.
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For example, if you add a Black & White filter to an image, but would like a faded, muted color effect, 
simply reduce the opacity of that filter. The more you reduce the opacity, the less effect the filter will have.

By default, when you add a filter, the opacity will be set to 100. You can create presets, however, with 
whatever opacity you wish for a given filter.

BLENDING MODES

In addition to opacity, you have one other very powerful 
option for adjusting the strength and effect of a filter: 
blending modes. Blend modes determine how a filter 
interacts with the filters below it in the image stack. Blend 
modes can darken or lighten an image, depending upon the 
mode chosen, while others adjust contrast or color. ON1 
Effects 2019’s blend modes also let you apply a blend mode 
to specific colors or tones in your image, making them a 
very useful tool for precision editing of your images. You can 
apply sharpening, for example, only to the midtones in an 
image, which can be very helpful in a landscape image.

To see the blending modes, click on the Blending Options 
gear icon at the top of a filter’s pane. The Blending Options area will drop down from the top of the panel. 
The blending option controls are:

• Blending Options: A pop-up list of blending modes. There are 24 common blending modes 
available in the list, including Normal, Lighten, Darken, Screen, Multiply, Soft Light, Hard 
Light, Overlay and Color.

• Apply To: This lets you apply the blending mode to a specific color or tonal range. The options 
are; All (the default), Highlights, Midtones, Shadows, Reds, Greens, Blues, Magentas, Cyans, 
Yellows, Flesh Colors, Vivid Colors and Neutrals. (You can also manually choose a color range 
by selecting the Dropper Tool in the 
pane and clicking on a color in your 
image.)

When you choose one of the options in this 
menu, the adjustment is only applied to that part 
of the image that is based on the lightness, hue, 
or saturation range specified. The Range slider 
expands or contracts the selected option, and 
the Highlights, Shadows, and Skin sliders protect 
those settings from your adjustments.

How blending modes work

At their basic level, blend modes determine how 
the pixels on one layer interact with the layers 
below it. With 24 blend modes in ON1 Effects 

Clicking the gear icon on the top right side of a filter’s title 
bar will open the Blending Options section.
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2019, it might be difficult to know which ones to use in any given situation, but they can easily be grouped 
into Normal (the default mode) and five categories: Darken, Lighten, Contrast, Comparison, and Color/
Luminosity. 

Normal is the most widely used: it simply applies the effect to all of the pixels in the adjustment (or effect), 
assuming the layer opacity is 100%.

The other modes apply different levels of that category’s effect using various mathematical formulas, 
and sometimes it can be hard to know which mode will work best with what photo. Most often, when 
you know how you want to apply an effect —by darkening, for example—you’ll need to perform a bit of 
experimentation with the different modes in that category to determine which mode works best.

MASTER OPACITY, BLENDING AND MASK OPTIONS

Effects also has master opacity and master blend mode options for the entire image stack, and includes a 
Master mask option. The Master Opacity slider, found at the top of the Effects tab, controls the strength of 
the composite filter stack against the original image—if you haven’t performed any other editing operations 
on it—or against the image as it has been inside the Effects module.

The Master Blend Mode options can be accessed via the gear icon at the top of the Effects tab. It has the 
same controls as the blending options in the individual filter panes.

To create a Master mask, click on the mask icon next to the Save Preset icon in the Effects tab. This mask 
works on the entire effects stack, letting you selectively add or remove an entire effect.

Filter Types
Effects has 27 filter types available for you to use inside ON1 Effects 2019. Each filter has a set of styles in 
the top row, providing a range of popular or useful options for using that filter. You can also save your own 
preset styles by clicking the More pop-up at the end of the Styles row.

ANTIQUE

The Antique filter gives your image an aged look; unlike the 
Vintage filter, this filter focuses more on a monochromatic or 
hand colored look.

• Color: Displays a list of color options that are similar in 
tone to the Split Tone filter, providing a duotone-style 
effect.

• Brightness: Adjusts the overall brightness of the image.

• Fade: Adds a white fill to the image, giving the illusion of 
a faded photograph.

• Saturation: Adjusts the color saturation. Moving the slider to the left decreases the saturation; 
moving it to the right increases it.

• Film Grain: Amount controls the strength and size dictates how large the grain appears.
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BLACK & WHITE

This pane is used to turn a color image into a monochromatic 
image, with some additional toning features to help you achieve a 
wide range of black-and-white styling options.

The styles at the top of the pane represent different filter types 
often applied to an image, while the Auto button selects the black 
and white points of your image automatically. To manipulate the 
tones manually, move the color range sliders to the right (increasing 
brightness) or the left (decreasing). Alternatively, you can choose 
the Channel Mixer option from the Conversion pop-up, and use 
the slider to choose a look that accentuates the color tones you are 
most interested in.

To change the tones directly inside a photo, choose the Color 
Response tool in the pane: click on it to select the tool, then click 
and drag in the image to increase or decrease the brightness of the 
selected color range.

Tone

The Tone section of the Black & White pane is similar to the one 
in the Tone Enhancer filter: you can adjust brightness, contrast, 
highlights and shadows, whites and blacks, and detail directly 
within the filter pane. (See Tone Enhancer on page 55 for more 
complete details on the options in the Tone section.)

Toner

The Toner section of the filter is designed to approximate many traditional and popular darkroom-based 
paper toners, from sepia tones to platinum, selenium, coffee and more. You can choose from more than 20 
toning options via the Type pop – up menu, and adjust the combination of paper (which is represented by 
the Highlights section of the pane) and silver (represented by the Shadows). To tune your options, you can 
adjust the Hue or Amount of each setting, and use the Swap tones icon (next to the Highlights color well) to 
swap the highlights and shadows colors. The Preserve Whites and Blacks button keeps the pure whites and 
pure blacks neutral, instead of taking on the color of the toner.

Film Grain

The last section of the Black & White pane is Film Grain, which, like the Toner section, is designed to add 
a classic film grain look to your photos. To add film grain, choose from the drop-down list of popular black 
and white films. The Amount slider controls the strength of the effect, while the Size slider adjusts the 
scale of the grain.
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BLEACH BYPASS

This filter is based upon an old color film processing technique 
where the bleaching step was skipped. It reduces the saturation 
and increases the contrast.

• Amount: Controls the strength or amount of the bleach 
bypass appearance.

• Brightness: Adjusts the overall brightness of the image.

• Contrast: Increases or decreases the global contrast.

• Detail: Enhances the details by increasing the micro 
contrast.

• Saturation: Adjusts the underlying saturation.

• Tint: Choose a new color by clicking in the color icon or by using the Hue slider.

• Amount: Adjusts the strength of the tint.

BLUR

This filter has five options for adding blur to your images: Gaussian, 
Motion, Radial, Surface and Box. Each blur has its own look:

• Gaussian: This is a simple Gaussian blur applied to your 
image. It has one slider, Amount, which controls the 
strength of the blur by adjusting the radius.

• Motion: A motion blur adds the appearance of movement.

• The Amount slider controls the strength of the blur, and Distance controls the blur 
relative to area between the subject and camera. Angle sets the angle of the blur, 
while the Smoothing slider softens the lines created by the motion.

• Radial: These blurs are circular, zooming out from a central point.

• Amount controls the strength of the blur. Quality controls how noisy the blur is, with 1 
being grainy and 100 smooth. Smoothing softens the lines created by the motion.

• The Radial blur type includes a center spot selector at the bottom of the pane. Click on 
the icon, then click on the part of the image you want to make the center of the blur.

• Surface: These blurs tend to maintain edges but add blur to the details. This blur type can give 
you a “simplified” effect. The Amount slider controls the strength of the blur, while Threshold 
sets how similar colors are grouped.

• Box: A Box blur is similar in concept to a Gaussian blur, but it bases the blur on contrasting 
edges. Box blurs tend to retain edges a bit more clearly than Gaussian blurs.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the amount sliders instead.
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BORDERS

ON1 Effects 2019 has a large collection of pre-made borders and 
edges that you can add to your photos. These borders range from 
classic film borders to viewfinders to artistic effects to emulsion 
transfers and many more.

The Borders filter also has an extensive set of controls for 
manipulating the size, color, and blending mode of the borders you 
choose.

You can also import your own borders, either directly into the 
Borders filter pane, or via the Extras Manager. Border files need to 
be a standard PNG file type with a large central transparent area.

The Category and Border pop-ups at the top of the pane are used 
to select the border category and the specific borders within each 
category. There are eight built-in categories, sorted by type. Any 
borders you have imported will also appear in this list.

Once you have chosen a border to add, you can adjust its blending mode and opacity, and, if the border has 
color, you can adjust its hue, saturation and brightness. Alternatively, if the border is black or white, you can 
colorize it.

The Transform section at the bottom of the Borders pane lets you scale the border up or down in size, to 
help you get the look you’re after, and the Fit Image slider adjusts the size of the image under the border.

You can rotate or flip the currently selected border by clicking the buttons at the bottom of the screen.

NOTE: See “Extras” on page 11 for information on how to use the Extras 
Manager to import borders, textures and other extras, along with additional 
information for preparing files for the Borders and Textures filters.

COLOR ADJUSTMENT

This pane lets you adjust specific ranges of color in your photos. 
The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky).

In the pane underneath are color swatches for eight colors: red, 
orange, yellow, green, aqua, blue, purple and magenta. Clicking 
on one of the colors will let you adjust the hue, saturation and 
brightness of the selected color range. Other settings in the pane 
include:

• Range: This slider lets you narrow or widen the range of the selected color.

• Hue: Changes the hue for the selected color range.
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• Saturation: Adjusts the saturation of the selected color range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to click on a section of your photo and adjust the hue, 
saturation or brightness dynamically. To do this, click on the tool and choose which parameter you would 
like to adjust. Then click in your image on a color you would like to adjust and drag the cursor to the left or 
right to decrease or increase the effect.

COLOR ENHANCER

The Color Enhancer is designed to give you complete control over 
color manipulation in your image, whether it is on a globally across 
your entire image, or by adjusting different color ranges. 

The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky). To adjust global 
color in an image, work in the Color section of the top half of the 
filter pane; to work with individual color ranges, use the Color 
Range section at the bottom of the pane.

Color

The Color sliders in the top half of the pane control Temperature, 
Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. The settings in this section of the 
Color Enhancer pane include:

• Auto Button: The auto button attempts to detect and remove a color cast. It makes 
adjustments to the Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. Click the icon to activate, then click on 
an area in the image that should be gray. The sliders will automatically adjust according to the 
sample you have selected.

• White Balance presets: Lets you change the white balance according to common color 
temperatures (As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, Custom). 
The default is As Shot, the color temperature recorded when you took the photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow).

• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases or decreases the color of muted tones, leaving more saturated colors alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.
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Color Range

In the Color Range section of the pane are swatches for eight colors: red, orange, yellow, green, aqua, blue, 
purple and magenta. Clicking on one of the colors will let you adjust the hue, saturation and brightness of 
the selected color range. Other settings in the pane include:

• Range: This slider lets you narrow or widen the range of the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to click on a section of your photo and adjust the hue, 
saturation or brightness dynamically. To do this, click on the tool and choose which parameter you would 
like to adjust. Then click in your image on a color you would like to adjust and drag the cursor to the left or 
right to decrease or increase the effect.

CROSS PROCESS

This filter simulates the effect of processing film deliberately 
with the incorrect chemistry. It creates unnatural colors and high 
contrast.

• Color: A drop-down list of cross-processing types (Blue, 
Green, Yellow, with Strong options).

• Amount: Controls the overall strength of the filter.

• Brightness: Adjusts the overall brightness.

• Contrast: Adjusts the overall contrast.

• Saturation: Adjusts the underlining saturation.

CURVES

The Curves pane is a powerful, advanced tool for adjusting 
contrast and color in your image. The buttons at the top of the 
pane let you adjust the composite RGB channel, or you can adjust 
the individual Red, Green or Blue channels independently.

In the main part of the pane, the left side of the X-axis represents 
the dark tones in your image, while the right side represents the 
light tones. By clicking on the line at the center of the pane and 
dragging it up or down, you adjust those specific tones making 
them lighter or darker. (It is often helpful to keep an eye on the 
Histogram when making adjustments with Curves.)



ON1 Effects 2019 from A-Z	 Part 2: Working in Effects	 49

DYNAMIC CONTRAST

Dynamic contrast adds clarity—also known as tonal contrast—to 
your image, making it pop. It can be a strong effect, so it is often 
combined with masks to help lessen the effect in certain areas of 
an image (clouds in a sky, for example, often look surreal with too 
much Dynamic Contrast applied to them).

The top portion of the pane adjusts the contrast in areas of small, 
medium and large detail; moving the slider to the left decreases the 
contrast, while moving the sliders to the right increases them.

Because adjusting the contrast in extreme ways can affect an 
image’s tonal qualities, the bottom section of the pane lets you 
make adjustments to the highlights and shadows to recover detail, in the white and black areas, and 
increase vibrance.

FILM GRAIN

The Film Grain filter is designed to add a classic film grain look 
to your photos. It operates identically to the section found in 
the Black & White filter, but lets you add grain without having to 
convert your photos to black and white. 

To add grain, choose from the drop-down list of popular black and 
white films. The Amount slider controls the strength of the effect, 
while the Size slider adjusts the scale of the grain.

GLOW

This pane adds a soft-focus glow to the image. The styles section 
and the More pop-up include a number of different glow types. 
Adjustable settings for the Glow pane include:

• Amount: Controls the overall glow strength.

• Halo: Sets the radius of the glow effect, creating a 
fuzziness to your image’s edges.

• Mode: Lets you set the blending mode for the glow effect.
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GRUNGE

This filter is used to add a dirty or grungy look to your image. 
Settings in this pane include:

• Amount: Adjusts the overall strength of the grunge.

• Brightness: Adjusts the overall brightness of the image.

• Saturation: Adjusts the underlying saturation.

• Detail: Adjusts the amount of detail.

• Glow Amount: Adds a glow to the grunge.

• Mode: Selects the glow blending mode.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.

HDR LOOK

This filter recreates the HDR style of tone mapping, with 
accentuated edges and sharpening. This one, like dynamic contrast, 
often benefit from masking or blend modes. Settings include:

• Compression: Compresses the tone to reveal highlight and 
shadow detail.

• Detail: Increases the local contrast of details and edges.

• Clarity: Increases the global contrast.

• Highlights: Recovers detail in the highlights.

• Shadows: Recovers detail in the shadows.

• Vibrance: Adjusts the vibrance of muted colors.

• Glow: Adds a bright glow.

• Grunge: Adds a dark gritty look.

LENS BLUR

This filter creates a blur, based on a camera lens such as a tilt-shift 
or a shallow depth of field look. You can use the Masking Bug to 
adjust the amount of blur through your image, or brush in or out 
the effect where you want it. The filters settings include:

• Amount: Adjusts the overall strength of the blur.

• Optic Quality: Controls the aperture shape in the inner 
and outer feather.

• Sides: Sets the number of blades in the lens aperture, 
which changes the shape of the bokeh.
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• Curvature: Sets the curvature of the aperture blades.

• Blooming: Adjusts the highlight bokeh.

• Brightness: Controls the overall brightness of the blur.

• Contrast: Controls the contrast of the blurred areas.

• Noise: Adds simulated film grain to the blurred areas.

LENS FLARE

The Lens Flare filter is used to create or enhance images shot into 
the sun. It reduces contrast, shifts color and renders a realistic lens 
flare.

• Type: Sets the style, either lens flare or sun spot.

• Amount: Adjusts the overall strength of the effect.

• Size: Controls the size of the effect.

• Light Source Tool: Click and drag with this tool to set the 
location of the light source. This can be off the image 
canvas, to give the effect of light coming in from outside 
the camera point of view.

• Camera Position Tool: Click and drag with this tool to set the location of the camera. This 
changes the shape of the lens flare. This can also be off the canvas.

• Show Rings: Shows or hides round aperture shaped artifacts in the lens flare.

• Color: Select a vintage color look.

• Amount: Control the amount of the vintage color look.

• Vibrance: Add vibrance to the underlying image.

• Fade: Decreases the shadow density by brightening the shadows. Adds a matte or faded look 
to your image.

• Blooming: Adjusts the highlight bokeh.

LUTS

The LUTs filter applies a color look-up table (LUT) to transform 
the underlying color of an image. LUTs were first used with video 
applications to provide color-grading (and other) effects to film, 
and they are increasingly popular in still photography. The Styles 
section has  a few default effects you can apply, and you can also 
import your own LUTs, by clicking the Import button inside the 
filter. (Effects can import common LUT file formats, including .3DL 
and .CUBE file types.)

• Category: This pop-up menu lets you choose from one of the pre-installed LUT categories, or 
any categories you have imported into Effects.

• LUT: Displays the available LUTs within the chosen category.
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• Contrast: Lets you adjust the underlying contrast.

• Saturation: Adds or reduces saturation.

NOTE: See “Extras” on page 11 for information on how to use the Extras 
Manager to import LUTs into Effects.

NOISE REDUCTION

Use this pane to reduce luminance and color noise, while 
maintaining image detail. The styles section includes a number 
of different noise reduction options, based on the type of image 
you’re working on.

• Luminance: Adjusts the overall strength of the noise 
reduction applied to the luminance or detail of the image. 
Hold down the Alt/Option key to see just the luminance 
while adjusting this slider.

• Color: Controls the amount of noise reduction applied just to the color or chroma of the 
image.

• Detail: Controls how much edge detail is protected. Hold down the Alt/Option key to see the 
edge mask while adjusting this slider.

• Apply to: Allows you to limit the noise reduction to just a portion of the image based on color 
or brightness values. Options include highlights, shadows and midtones, as well as color 
ranges. To set a custom color range, click the Dropper icon and click on a color area that has 
the noise you wish to remove. Use the Range slider to adjust the range or fuzziness of the 
color range to apply the noise reduction to.

PHOTO FILTER

This filter recreates traditional, solid color lens filters used for 
warming and cooling effects, as well as gradient, bi-color and 
center-spot filters. You choose the filter type from the pop-up 
menu at the top of the pane, then adjust the settings to your 
liking. Each type offers different options for selecting a filter color 
(or colors, in the case of the Bi-Color type), adding saturation or 
polarization, and more.

The Solid option includes a section for choosing the single color 
you wish the filter to be, and an Amount slider for how strong you 
want the effect. The Polarizer slider adds a polarization effect, which can sometimes help clear haze or 
enhance the blues and greens in an image.

The Bi-Color and Graduated filter options let you choose filter color (or colors), feather for the filter 
transition, and a direction for the effect.
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The Center type works much like the Graduated option, with the difference being that the filter radiates 
from the center of your image, and you can choose the center to be either clear or colored.

SHARPENING

This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 Effects 2019 offers three algorithms for 
sharpening, High-Pass, Progressive and Unsharp Mask. Which one 
you use depends upon the image or your personal preferences. 
The styles section and the More pop-up have a wide range of 
sharpening styles to help you get started.

• Type: Chooses the sharpening method. Each sharpening 
method has its own set of sliders.

• Amount (all types): Controls the overall strength of the sharpening for each sharpening type.

• Halo (Unsharp Mask, High Pass): Sets the radius of the sharpening effect. Smaller amounts keep 
fine detail, while larger amounts can exaggerate edge detail.

• Threshold (Unsharp Mask, Progressive): Controls the sharpening effect based on contrast in 
your photo. Larger settings means that smoother areas do not get sharpened.

• Detail (Progressive only): Controls sharpening in small details.

• The Protect section protects highlight, and shadow areas and skin tones from having 
sharpening applied.

SKIN RETOUCHING

The Skin Retouching pane is used to reduce blemishes, smooth 
skin and reduce shine on skin. The styles at the top of the pane 
represent a range of adjustments, from subtle to strong, and the 
More pop-up menu has a number of additional styles for you to 
choose from, depending upon your image. Other settings include:

• Blemishes: Adjusts the strength of acne, pores and fine 
lines.

• Smoothing: Adjusts the strength of smoothing similar to 
makeup foundation.

• Shine: Adjusts the strength of the skin shine.

• Evenness: Adjusts skin color consistency across the entire face. It is great for correcting overly 
yellow highlights, shadows that may be green or reducing redness in noses and ears.

• Skin Color: Use the Color Dropper icon to select the skin color. Click the icon to activate it and 
single click again on the color of the skin in the image.

• Color Well: This will display the color you have chosen with the Color Dropper. Clicking on the 
well will let you choose a different color to represent the skin.

• Range: Adjusts the precision of the color selected.
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SPLIT TONE

This filter applies a duotone-style effect by using a gradient map 
that tints the dark and light portions of the image in different hues. 
This can be used to age an image and give it an antique or vintage 
look. The styles section has a selection of popular split-tone 
effects, and you can create your own by manipulating the sliders to 
choose a map for the highlight and shadow colors.

To use the pane, you can use the Hue slider in each of the sections 
to choose the colors you want for highlights and shadows. The 
Amount slider controls the strength of the color, and Balance sets 
the balance between the shadow and highlight colors, letting you 
make one of the colors more dominant.

The Mode pop-up sets the blending mode for the split tone. The options you can choose from are Normal 
(no blending), Color, Lighten, Darken, Multiply or Screen.

SUNSHINE

This filter increases the appearance of sunshine in a photo, and can 
help to make a flat, cloudy day more vivid. The controls are fairly 
straightforward, including adjustments for the strength (Amount), 
warmth and saturation. You can use the Glow slider to add a bright 
glow to your image.

TEXTURES

The Textures filter places a texture over the image to add a stylized 
look and is similar to the Borders filter in scope and functionality. 
ON1 Effects 2019 comes with an extensive set of textures that 
you can add to your photos, ranging from fabric, metal, stone, text 
and more. You can also import your own textures directly into the 
Borders filter pane, or via the Extras Manager. Texture files can be 
almost any image format (JPEG, TIFF, Raw or Photoshop).

When loading a texture file, it will be rotated automatically to 
match the orientation of your image. You can override this with 
the rotate and flip tools, and use the Transform option to scale the 
texture’s size over your image.

The Texture option has Category and Texture pop-ups, used 
to help you narrow your texture search. There are nine texture 
categories, and user-imported textures will also appear in this list.

Once you have chosen a texture, you can adjust its blending mode 
and opacity, and, if the texture has color, you can adjust its hue, saturation and brightness. Alternatively, if the 
texture is black or white, you can colorize it by clicking on the Colorize button in the bottom half of the pane.
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The Transform section at the bottom of the pane lets you scale the texture up or down in size. You can 
also rotate or flip the texture by clicking the buttons at the bottom of the screen, which can be helpful to 
achieve the look you desire.

NOTE: See “Extras” on page 11 for information on how to use the 
Extras Manager to import textures (and other extras), along with additional 
information for preparing files for Borders and Textures.

TONE ENHANCER

The Tone Enhancer controls the brightness and contrast, or tone, 
of the image and lets you recover detail in the highlights and 
shadows, and adjust the white or black point. It also includes a 
Curves section if you wish to fine tune your image in that manner.

• Auto Button: The auto button sets the white and black 
points automatically, adjusting all of the primary tone 
settings to balance the histogram.

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast in your image.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing 
contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing 
contrast in the shadows.

• Compression: Compresses the tone to reveal highlight and 
shadow detail.

• Detail: Increases the local contrast in the image.

• Clarity: Enhances large edges to add clarity.

• Curves: The Curves dialog is a powerful, advanced tool for adjusting contrast and color. (See 
the Curves filter on page 48 for more on how to adjust tone curves.)
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VIGNETTE

The Vignette pane creates flexible vignettes which focus a viewer’s 
eye toward the center of the image by darkening the edges of the 
frame. The buttons at the top of the pane let you quickly apply a 
vignette and then customize the look with the advanced controls. 
Styles apply common vignette types.

• Brightness: Controls how light or dark the vignette is.

• Size: Controls the size of the vignette.

• Feather: Controls the hardness of the edge of the 
vignette.

• Roundness: Controls the shape of the vignette from square to round.

• Type: This drop-down menu lets you select a Normal, Subtle, or Soft vignette effect. The 
Priority option will let you preserve highlights (using the Tone & Color pane in Develop or the 
Tone Enhancer filter in Effects) when applying the vignette.

The Center Tool at the bottom left of the pane lets you to select the center point of the vignette. Click 
on the tool icon to activate and then click on the area in the image you wish to make the center of your 
vignette.

VINTAGE

The Vintage filter is for adding an aged, vintage look reminiscent of 
films and photographic papers from the mid-to-late 20th Century.

• Color: A drop-down menu of various color styles to apply 
to your image.

• Amount: Controls the overall strength of the filter.

• Saturation: Adjusts the saturation of the original image.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.
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Local Adjustments
You can easily make local adjustments to portions of 
an image in ON1 Effects 2019. You can apply these 
adjustments using either the Adjustment Brush or the 
Adjustable Gradient (or both, if desired). You can create 
as many local adjustments as you need on an image (by 
clicking on the Add Layer button at the top of the Local 
Adjustments section). 

Local adjustments can be used to apply a gradient filter to 
darken a sky, for example, or to add a more complicated 
vignette to an image. Local adjustments are in essence a 
mask that is applied to a portion of your image, and you 
can manipulate those masks in powerful ways with both 
the blending modes and the luminosity options in the Local 
tabs.

Operations you can perform with local adjustments include 
tone (exposure, contrast, highlights and shadows, detail), 
color (white balance, saturation and vibrance) and detail 
(structure and noise). Each local adjustment layer can have 
completely different settings and work on different parts 
of your image. You can also use local adjustments to paint 
with color over part of a photo, to perform specialized 
tasks such as skin retouching or to replace the color of an 
object. 

Local adjustments are independent from the Effects tab; 
you can create a local adjustment, switch to Effects, and 
when you click back on the Local tab, your local adjustments remain intact.

TIP: You can name each adjustment layer by double-clicking on the word 
‘Adjustment’ in the pane. This can be helpful when you have many adjustment 
layers and wish to remember which adjustment did what.

LOCAL TAB

To create a local adjustment, click on the Local tab. If there are no local adjustment layers present, Effects 
will add one. If you want to add additional adjustment layers, click the Add Layer button. The top of each 
adjustment layer includes the following options:

• Opacity: Sets the opacity of the adjustment.

• Styles: The pane has a number of canned styles for you to start with, including ones for 
lightening or darkening (dodging and burning), adding vibrance, fixing teeth or red eye, and 
many more. (You can also save your own styles via the More pop-up menu.)

Adjustment panes let you adjust basic tone and color 
settings on the parts of the image you choose. You can 
also set the opacity of the adjustment, as well as apply 
masks (via the mask icon, top) and advanced blending 
options (accessed via the gear menu).
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The main section of the Local tab has all of the same options found in the Tone Enhancer and Color 
Enhancer filters: Exposure, Contrast, Highlights, Shadows, Detail, and Color Temperature, Tint, Saturation 
and Vibrance. In addition to those settings, a Local Adjustment pane includes a Noise slider, designed to 
help reduce noise on a targeted level (most often seen in the shadows).

These controls work the same way inside the Local Adjustments panel. One difference is that, since a local 
adjustment is actually a layer that sits on top of your global adjustments, ON1 Effects 2019 provides you 
with a number of blending options for each adjustment. Blending modes determine how the selected layer 
blend with the items below it in the image stack.

Click on the Blending Options gear icon at the top of the Local tab to drop down the Blending Options. The 
blending option controls are:

• Blending Options: A pop-up list of blending modes. There 
are 24 common blending modes available in the list, 
including Normal, Lighten, Darken, Screen, Multiply, Soft 
Light, Hard Light, Overlay and Color.

• Apply To: This lets you apply the blending mode to a 
specific color or tonal range. The options are; All (the 
default), Highlights, Midtones, Shadows, Reds, Greens, 
Blues, Magentas, Cyans, Yellows, Flesh Colors, Vivid 
Colors and Neutrals. (You can also manually choose a 
color range by selecting the Dropper Tool in the pane and 
clicking on a color in your image.) 
 When you choose one of the options in this menu, 
the adjustment is only applied to that part of the image 
that is based on the lightness, hue, or saturation range 
specified. The Range slider expands or contracts the selected option, and the Highlights, 
Shadows, and Skin sliders protect those settings from your adjustments.

About blending modes

At their basic level, blend modes determine how the pixels on one layer interact with the layers below 
it. With 24 blend modes, it might be difficult to know which ones to use in any given situation, but they 
can easily be grouped into Normal (the default mode) and five categories: Darken, Lighten, Contrast, 
Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies the effect to all of the pixels in the adjustment (or effect), 
assuming the layer opacity is 100%.

The other modes apply different levels of that category’s effect using various mathematical formulas, and 
sometimes it can be hard to know which mode will work best with what photo. Most often, when you know 
how you want to apply an effect—darkening, for example—perform some experimentation with the modes 
in that category to determine which mode works best. (See Blending Modes on page 42 for more.)

Painting with Color

The Paint with Color option at the bottom of the local adjustment panel lets you use the Local Adjustment 
brush to select a color and paint it into your image. It is designed for two situations: when you wish to apply 

The Adjustment pane’s Blending controls give you 
extensive options for applying local adjustments to 
targeted tonal and color ranges in an image.



ON1 Effects 2019 from A-Z	 Part 2: Working in Effects	 59

softening (or evening out) to portions of an image by blending existing color, and to replace the color of an 
existing object. 

The Paint with Color section has three options, Solid Paint, Replace Color, and Classic, and a color swatch 
for the chosen color. You can choose a color from your image by 
clicking on the eyedropper icon, or you can click on the swatch and 
choose a color from the system color picker. 

Solid Paint will paint over anything you brush with the chosen color; think of it as painting with a Normal 
blending mode. Replace Color will replace the hue, but not the luminosity, of the color you are brushing 
over; it is essentially painting with a Color blend mode, in which whites are preserved. 

The Solid Paint option is an ideal skin softening tool; use the eyedropper to select a middle tone section of 
skin, and, using a low opacity setting on your brush, you can paint over parts of the skin with the brush. 

WORKING WITH LOCAL ADJUSTMENTS

When adding a local adjustment layer, click on the tool you wish to use in the Tool Options bar at the top 
of the window. The Adjustment Brush is perfect for working with specific subjects or areas in an image: 
a person or primary object that you wish to brighten, shadow areas that you wish to darken, and more. 
It works in the same manner as the regular Masking Brush: you set the paint mode (in or out), brush size, 
feather and opacity, and brush in the areas you wish to paint an effect in or out.

The Adjustable Gradient is designed to apply a gradient mask over a section of an image: most commonly to 
darken a sky, for example. Because the local adjustment tools are for working on a mask, you have all of the 
masking and blending options you have throughout Effects, and you can use one or both tools—in addition 
to the Refine, Chisel and Blur Mask tools—to refine your adjustment mask as desired. 

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 

One frequent use for local adjustments is to darken a sky, with the Adjustable Gradient tool.
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horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

TIP: To see the mask created by the Adjustable Gradient, choose Show Mask 
from the View menu. You can choose a red overlay, which presents the mask 
over your image, or grayscale, which shows the mask as black to white tones. 
These views can be helpful in understanding how these gradients work.

Manipulating a Linear Gradient Mask 

Once you’ve added a gradient to an image, you can modify it by accessing the parts of the gradient overlay: 

• To move a gradient, click on the big circle at the center of the gradient and drag. 

• To resize a radial gradient, click and drag on the solid line. 

• To adjust the feather (hardness) of the mask, click and drag along the dashed line. 

• To rotate the mask, click the smaller circle near the gradient center and drag. 

When working with local adjustment masks, all of the tools in the Refine group—the Refine Mask, and the 
Chisel and Blur tools—can be used to help give you create smoother and more realistic masks.

Other masking options

Every local adjustment has its own mask, and it uses the same masking options and controls found in 
Effects and Layers. To access the mask, click on the mask icon in the title bar of the local adjustment layer. 
There you can copy and paste masks, create luminosity masks, and create masks based on color ranges. For 
specific details on how to work with these masking options, see Filter Masks on page 39.
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PART 3: OUTPUT AND SHARING
While editing and organizing your photos are probably the most important 
tasks you’ll do on a regular basis inside ON1 Effects 2019, there will be 
times when you want to “do something else” with your photos. Whether it’s 
enlarging photos for high-quality prints, sharing your photos with others 
or on social media, or printing to your desktop printer, Effects has all the 
functionality you’ll need to get your photos where you want them to be. 

In this section, you’ll find detailed information on the following topics:

• Export: The power of ON1’s Perfect Resize technology in a quick 
and easy-to-use panel, letting you export your photos with 
flexibility, ease and control.

• Share: A quick way to share your photos via email, social media and 
more.

• Print: Print your photos whenever you wish.

Export
The Export panel (shown on the right) is the engine for Effects’ 
export process, giving you much of the power of ON1’s Resize 
2019 app in a quick and easy-to-use format, letting you export 

your photos with incredible flexibility, ease and control.

To open the panel, click on the Export icon in the lower right corner of 
the main Effects window, or can choose Export from the File menu. Once 
selected, the Export panel opens on the right side of the Effects window, 
letting you select a group of options as you prepare to export a photo. 
By default, the panel includes three panes near the bottom of the panel: 
File Type, Location, and Rename. These are fairly straightforward in their 
operation, and are the minimum options needed to export a file, but you 
can also turn on the following panes in the panel, expanding your export 
controls: Photo Size, Watermark, Sharpening, Tiling and Gallery Wrap. 
(To turn on one of the optional settings, click the button to the left of the 
option’s title in the Export panel.)

FILE TYPE

The File Type lets you choose what format you want your photo to be 
exported as, along with a color profile that you wish to assign to the 
exported file. The available file type options for export are Photoshop, 
Photoshop Large Document, JPEG, TIFF, and PNG.

Saving as JPEG lets you choose a Quality setting, with 100 being the highest.
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LOCATION

Click the Choose button to select a location, or click on the Save To 
pop-up for more options, including:

• Current Folder will write the file to the same location as the 
original file.

• Folder lets you choose a location by pressing the Choose 
button

• Round Trip (this option is only available exporting through Adobe Lightroom) saves the file 
over the original and uses the same format, bit-depth, color space and name.

With regard to the other options in this pane, If Prevent Overwrite is selected the word ‘copy’ will be added 
to the file(s); otherwise it will overwrite your original image if the destination is set to Current Location. You 
can also have Effects open the folder you exported your image to by choosing the Show in Finder (Mac OS) 
or Show in Explorer (Windows) option from the After Export pop-up menu.

RENAME

This option may be used to rename the file name. The options 
include: Current Name, Text, Date and Number. The field to the 
right allows you to enter a custom name. The plus and minus icons 
will allow you to add or remove naming elements. Current Name 
will use the source name without the file extension. Text is used 
for assigning a custom text string. Date lets you add today’s date in 
any one of 12 standard formats. Number creates an automatically 
incremented number, starting with the number input in the field. 
Reset will clear all current settings.

PHOTO SIZE

The Photo Size pane displays the original image size when you 
first open it. You can simply type into the Width or Height fields 
to change the document size, or you can choose from a variety of 
preset sizes—including standard photo paper sizes—by clicking on 
the pop-up menu underneath the Resize To pop-up.

NOTE: Export does not offer any options for cropping, and if you choose an 
aspect ratio that is different from that of your photo, on export, your photo will 
be cropped—from the center point out—to meet the new ratio. It is best to crop 
your photo with Effects’ Crop tool first. See the “Crop Tool” on page 18 for 
more on how to perform this operation.
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The Width and Height fields are locked together to maintain a photo’s proportions. Changing the width will 
change the height proportionally. Export does not support non-proportional scaling. If you would like to 
change the proportions of the image, you will need to crop it.

The Long Edge and Short Edge options in the Photo Size pane are useful when you want to lock one 
edge to a specific length or width and don’t care about the sizing of the other edge. Simply choose 
which option is the important one for your photo, enter the dimensions, and Export will resize your 
photo accordingly.

The units of measurement can be switched by clicking the down arrow. You also control your resolution in 
pixels per inch. Use this setting to optimize for your output device.

The Photo Size Presets make it easy to set the width/height of your image in a preset size. Use the drop 
down menu to select a preset size or choose custom to create your own.

The Image Type drop down provides a few options for resizing:

• General (ON1 Resize) uses the ON1 Resize algorithm also known as Genuine Fractals: This is 
the classic, patented, fractal-based algorithm that has made Perfect Resize the standard for 
over a decade.

• Low-Res JPG is best for enlarging low resolution JPEGs (this setting use the bicubic algorithm 
method).

• Portrait works well for resizing portraits protects skin tones from artifacts (uses bicubic 
algorithm method).

• Landscape is great for Landscape photos (uses ON1 Resize algorithm).

• High Detail is great for images with many small items (uses ON1 Resize algorithm).

WATERMARK

The Watermark module allows you to add an overlay to the image, 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you wish 
to use as your watermark.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the file 
is inset from the edge.

• Opacity: This sets the opacity of the watermark.

• Location: This grid sets the location of the watermark. Click 
on the square of the location you desire.
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TIP: When working with watermarks, make sure your watermark file is 
sufficiently large for your usage. For example, if you want it to appear two 
inches wide on a 300-ppi image, your watermark needs to be at least 600 pixels 
wide. Or if you want it to appear across an entire photo—such as when posting 
to social media—it needs to be the same size as what you are exporting for the 
web, typically over 1000 pixels. Using a watermark file that is too small will 
create a pixelated watermark appearance.

SHARPENING

The Sharpening pane adds additional sharpness to your image, and 
are designed to be general options for either screen or print work. 
Using the Sharpening controls can help compensate for loss of 
sharpness due to dot gain from your printer. Sharpening should only be applied at the end of your workflow 
just before printing. If you plan to do additional retouching or compositing work after resizing your image, 
you should disable the sharpening controls.

TILING

The tiling feature in Export divides an enlargement into smaller 
pieces so that the image can be printed on a smaller printer.

For example, you might want to create a mural that is 8 feet tall by 
12 feet wide, but your printer can only print 24-inch wide strips. 
With the tiling feature you could automatically create four separate 
files that are 24 inches wide and 8 feet tall, to create your mural in 
sections.

With the tiling feature all you do is specify the size of paper you 
have to print on and if you would like the pages to overlap. Then 
Export will resize your image and section it down into the individual 
tiles.

To use the Tiling pane, follow these instructions:

1.	 Set the Width/Height fields to the size and orientation of 
paper you wish to print on, or select the number of rows 
and columns instead.

2.	 Set the Overlap size. The overlap makes each tile overlap so you can tape multiple panels 
together and corrects for printer margins if you are not printing borderless.

The preview will show cyan guide lines for each tile that will be created.
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GALLERY WRAP

The Gallery Wrap feature is designed to help you print on canvas. 
When making enlargements for canvas it is common to wrap a 
portion of the image around wooden stretcher bars. These are used 
for mounting the canvas. These are commonly called gallery wraps. 
However, if the photo has important detail near the edges of the 
image they may be lost in the wrapping process. The Gallery Wrap 
feature in ON1 Resize automatically creates extended margins 
by reflecting or stretching the areas near the edge of the image 
allowing the photographer to create a gallery wrap without having to 
sacrifice any of the original image. The Gallery Wrap feature allows 
you to select the thickness of the canvas mounting bars and offers a 
variety of techniques for creating additional margins.

To use the Gallery Wrap feature follow these instructions:

1.	 Set the Thickness control to the amount of margins you 
would like to add. A good rule of thumb is the thickness 
of the stretcher bars, plus half an inch.

2.	 Select the Type you would like to use.

3.	 If you wish to add an overlay to the wrap wings, set the color and opacity.

The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap. The 
Type pop-up has four options:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general purpose technique.

• Reflect Soft: Does the same as the Reflect method but softens the added margins.

• Stretch: The Stretch method takes a small area around the edge of the image and stretches it 
to add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

You can also darken the wrap or add a solid color to the wrap area with the Overlay Color add Opacity 
sliders.

EXPORT PRESETS

Presets remember all of the settings and details selected in the Export window pane. To save a group of 
settings as a preset, click the Save Preset button at the bottom of the panel. Give the preset a name, and it 
will appear in the Presets pop-up at the top of the Export panel. 
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Sharing (Mac OS only)
While the Export feature is great for exporting photos quickly—and with a wide degree of 
options—sometimes you just want to share your photos via email, on social media, or to the 
photo-sharing website Flickr. For these quick-and-dirty operations, ON1 Effects 2019’s Sharing 
feature is the way to go.

NOTE: Because it uses Apple’s built-in sharing functionality, the Sharing 
feature in Effects is only available on Mac OS.

Found throughout Effects in the lower right of the Module selector, the Sharing button has a pop-up that 
lists available sharing targets. All of the sharing options perform the same operation: Effects exports a full-
size JPEG of the selected photo and shares it with the selected target from the list. 

The sharing options are as follows:

• Mail: Creates a new email message in Apple Mail with the shared photo.

• AirDrop: Uses Apple’s AirDrop networking feature to share with local Mac 
OS or iOS devices. 

• Twitter: Shares photo via Twitter. (Not available in Mac OS 10.14 and 
higher.)

• Facebook: Shares photo on Facebook. (Not available in Mac OS 10.14 and 
higher.)

• Notes: Adds the shared photo to Apple’s Notes app. You can choose to create a new note, or 
add the photo to an existing note.

• Messages: Shares photo to Apple’s Messages app.

• Add to Photos: Adds the photo to Apple’s Photos app.

• Flickr: Creates a new Flickr post with the shared photo. (Not available in Mac OS 10.14 and 
higher.)

In each instance above, Effects’ Sharing feature lets you add any additional information before completing 
the operation. For example, you can add hashtags and descriptions to your photo, or any additional notes. 
(Effects includes a #on1pics hashtag where applicable, but you can easily delete this before sharing, if you 
would like.
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Printing
ON1 Effects 2019 has full printing capabilities built directly into the product, and you can print your photos 
using the Print command from the File menu.

To print an image, follow these steps:

1.	 Select Print from the File menu.

2.	 Select your printer from the Printer pop-up.

3.	 Press the Print Setup button to adjust printer specific options such as paper size and type 
and printer specific color management options.

4.	 Adjust the number of copies, orientation and output resolution.

5.	 In the Print Area section set the area to fit, fill or actual size. The preview on the left shows 
the paper size and margins as well as the print area and how the image will fit or fill the print 
area. (When using Fill Entire Area, you can move the photo around the print area box.)

6.	 Select the output Printer Profile and Rendering Intent to properly adjust the photos colors 
to your printer and paper combination. You may also select the Printer Managed Color 
option to let your printer driver manage the color instead.

TIP: If you have already cropped and sized your image to your desired print 
area size, simply set the width and height to match in the Print Area section.
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Effects Menus
ON1 Effects 2019 (Mac OS Only)

• About ON1 Effects 2019: Opens the About box and displays 
your version number. (This is in the Help menu on Windows)

• Preferences: Opens the preferences dialog. (In the Edit menu 
on Windows)

• Quit ON1 Effects 2019: Quits Effects.

File Menu

• Done: Saves the edits made to your photo and closes the file.

• Cancel: Closes the current photo without saving any edits.

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format.

• Export: Opens the export side panel.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to the current 
location.

• Delete: Deletes the current image (Filmstrip mode only).

• Preferences (Windows): Opens the Preferences dialog.
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Mask Menu

• Invert Mask: Inverts the mask, what was hidden is revealed 
and vice versa.

• Reset Mask: Resets the mask to plain white.

• Copy Mask: Copies the mask.

• Paste Mask: Pastes the mask.

• Create Luminosity Mask: Creates a luminosity layer mask 
based off of a photo’s black or white tonal values.

• Show Mask: Displays the current mask either as a red overlay 
or as grayscale.

• View Mode: Sets the Show Mask mode to either red overlay 
or grayscale.

Settings Menu
• Reset All Settings: Resets all the applied settings on a photo.

• Reset Effects Settings: Resets settings applied in Effects.

• Reset All Retouching Tools: Resets retouching applied in Edit. 

• Reset Local Adjustments: Resets any local adjustments.

• Reset Crop: Resets any cropping made to a photo.

• Save Settings as Preset: Saves the editing settings of the 
selected photo as a preset.

• Update Preset with Current Settings: If an image with a 
preset has had some settings changed, this lets you update 
the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1’s Photo Presets web page.
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View Menu

• Zoom In: Zooms the preview window in one increment. This 
will make the preview image larger.

• Zoom Out: Zooms the preview window out one increment. 
This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.

• Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you 
to see every pixel in the image. This is useful when making 
precision adjustments.

• Browser Mode: Sets the Preset panel browser view to 1, 2 or 
3 columns.

• Show Clipping: Shows the clipping overlay view, displaying 
the pure white or black pixels in the current image.

• Show Preview: Toggle to enable or disable the preview.

• Compare: Displays a split-screen view of the current image, 
with the Before view on the left side of the preview area.

• View Mode: Set to Photo View (Detail).

• Preview Background Color: Lets you set the background 
color options.

• Enables Soft Proofing: Turns on soft proofing for the current 
image.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display profiles; 
choosing a profile will apply soft proofing for that profile’s 
paper type.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, Effects will set the 
white point and black point of the display to account for that 
of the chosen profile.
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Window
• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size.

• Full Screen: Toggles full-screen mode (hides menus).

• Navigator: Hides or shows the Navigator, Levels and Info 
pane.

• Solo Mode: Keeps only one pane open at a time.

• Open Quick View Browser: Opens the Quick View Browser 
overlay for the selected preset category.

• Show Bumper Labels: Hides/reveals the text labels in the 
module selector.

• Show Browser Panel: Hides/shows the Browser (left) panel.

• Show Control Panel: Hides/shows the Control (right) panel.

• Hide Panels: Hides or shows all panels.

• Document Name: Shows the name, zoom level and bit depth 
of the open image.

Help
• Search: Searches the menu options (Mac OS only).

• ON1 Effects 2019 Online Help: Opens ON1.com support 
page in your default web browser.

• Video Tutorials: Opens ON1.com product training page in 
your default web browser.

• Welcome to ON1 Effects 2019: Displays the Welcome 
window.

• Check for Updates: Checks with the ON1 update server to 
see if you are running the current version. If there is a newer 
version, you will be notified and be walked through the 
update process.

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 Effects 2019.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• About ON1 Develop (Windows Only): Opens the about box 
with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Effects 2019.



ON1 Effects 2019 from A-Z	 Part 4: Reference	 73

Preferences
ON1 Effects 2019 has a number of system-wide settings that you can set via the Preferences window. To 
access Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences 
from the ON1 Effects 2019 menu (Mac OS) or the Edit menu in Windows.

The Preferences window has four tabs: General, Files, Plug-Ins, and System. The settings in each tab are 
described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the Effects workspace, including background 
color, scrolling controls and more.

Scrolling Controls

Lets you select how the mouse scroll wheel or 
scrolling gesture works. The options are:

• None: Default.

• Preview Zoom: Adjusts the zoom of the preview window. Scrolling up increases the zoom, 
scrolling down decreases the zoom.

• Preview Pan: Pans the image, like using the pan tool or navigator. It is important that the 
panning is comfortable, not too fast or slow or jerky.

• Brush Size: Adjusts the size of the current tool if relevant, such as a brush tool.

Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is 
options for black, white, light gray, dark gray and custom. The custom option has a color picker where you 
can select your own background color.

Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the Effects interface.

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start 
Effects; if an update is available it will prompt you to download or skip.
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FILES

The Files tab is used to determine what file type 
ON1 Effects will create when opening a file as a 
plug-in from an external application.

What to Edit

There are five options in the What to Edit 
section of the Files tab:

1.	 File Format: Sets the file type you 
wish to create: PSD, TIFF, or JPEG. If 
you wish to use a layered workflow, 
you must choose PSD.

2.	 Color Space: Sets the default color space when opening a copy of a file; the list includes 
Adobe RGB 1998, Apple RGB (Mac OS), sRGB, ProPhoto RGB, or ColorMatch RGB.

3.	 Bit Depth: Sets the bit depth for the file when opening a copy of a file.

4.	 Resolution: Sets the resolution when opening a copy of a file.

5.	 Show these options every time: If you do not wish to use a predefined set of file characteristics 
for opening photos from Lightroom or Photoshop, click this box.

Apply Lens Correction Automatically to Raw Photos

With this option on, ON1 Effects will use the lens correction automatically on any raw photo when you 
view it in Detail, Filmstrip or Compare modes.

PLUG-INS

The Plug-Ins tab is specific to using Effects as a 
plug-in for Photoshop or Lightroom, and lets you 
set up conditions when opening files from these 
apps.

Photoshop

• Apply Results to: When editing in 
Photoshop you can choose to have 
your effect added to a copy of your 
current layer or to the current layer. 
You can also choose to start with the 
last used settings when launching 
Effects.



ON1 Effects 2019 from A-Z	 Part 4: Reference	 75

Lightroom

As shown in the Working with Lightroom section above, this preference lets you choose the specific 
options for files opened via the Plug-In Extras menu in Lightroom:

• Save Photoshop Files As: Controls how Photoshop files opened from Lightroom are saved, as 
smart photos or regular PSDs.

• File Type: The file type drop-down menu determines what type of file will be created. The 
default is PSD, which maintains layers. You can also select JPG or TIFF if you prefer those 
formats and are not concerned about maintaining layers. The last option is same as source, 
which maintains the file type of the original file, except for Lightroom raw files, which are 
saved as PSDs.

• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited 
directly, rather than having a copy made.

SYSTEM

The System tab displays performance-related 
characteristics of Effects 2019.

Memory Usage

• System Usage: Specifies the amount of 
RAM that is used by the application. 
The maximum (default value) is 80%.

• VRAM Usage: Specifies the amount of 
video memory (VRAM) that is used 
by the application. The maximum 
(default) is 80%.

Scratch Folder Location

The memory cache (scratch folder) helps speed editing operations while you’re running Effects. Here, you 
move your memory cache to a different location (drive) or reset it. This can be helpful if your system drive 
has limited space or you wish to use a faster external drive as a cache. This cache information is purged 
each time you quit the application.

Performance (Fast panning and GPU Render)

Fast panning is available when you’re viewing an image at 100% in Detail view, and is designed to give you 
better performance when using the Hand tool to pan around the image, With this setting on, as you pan, 
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Effects will display the image at a lower quality; as soon as you let go of the mouse, the app will then show 
the pixels at their highest quality.

If you have a discrete graphics card (GPU) installed with your system, the GPU Render option will utilize 
that card instead of your CPU for some tasks, making them run faster. For example, your video card will 
help speed-up common processes like copying and pasting masks, as well as some exporting and plug-in 
usage.
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